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Software License and Warranty Agreement For QuarkXPress™

ATTENTION!

THIS IS A LICENSE AGREEMENT. THIS DOCUMENT
SETS FORTH THE TERMS AND CONDITIONS OF THE
LICENSE AND THE LIMITED WARRANTY FOR QUARK
XPRESS. BREAKING THE LABEL ON THE ENCLOSED
DISKS SIGNIFIES YOUR ACCEPTANCE OF THIS
AGREEMENT. IF YOU DO NOT ACCEPT THIS
AGREEMENT, YOU MAY RETURN THE SOFTWARE TO
THE PLACE OF PURCHASE AND YOUR MONEY WILL
BE REFUNDED.

1. LICENSE GRANT: Customer does not receive title to
QuarkXPress. The customer is granted a nonexclusive
license to use QuarkXPress on a single computer work
station. QuarkXPress cannot be pooled or shared among or
between multiple computers through networking or other
similar communication packages. Each computer is required
to have its copy of QuarkXPress. QuarkXPress may not be
rented for multiple use.

2. COPYING RESTRICTIONS: Customer may copy Quark
XPress under certain restrictions. Customer may make a
backup copy or copy onto a hard disk. No more than two (2)
copies of QuarkXPress are permitted to be in existence at
any one time for each purchased package. Every copy must
include all notices and markings contained in the original
provided by Quark, Inc.™

3. TRANSFER OF QUARKXPRESS: Customer may not
transfer QuarkXPress.

4. CUSTOMER COMMUNICATION OF LICENSE
AGREEMENT: Customer agrees to tell or communicate to
all persons under his employment, direction or control of
the restrictions contained in this License Agreement.

5. UNAUTHORIZED USE AND COMPLIANCE:
Customer will use all reasonable efforts to see that
employees, agents, assigns or other persons under the
direction or control of customer abide by the terms and
conditions of the QuarkXPress License Agreement. No
person should be allowed or permitted or use any portion
of QuarkXPress for the purpose of deriving its source code.
Customer agrees to notify Quark, Inc. of any unauthorized
use in writing.

6. GENERAL PROVISIONS AND WARRANTY: Quark,
Inc. warrants that for ninety (90) days after purchase of
QuarkXPress by the customer, QuarkXPress shall
reasonably conform to the standards defined in the
accompanying documentation (manuals and computer
aided instructions). Quark, Inc. specifically does not warrant
that QuarkXPress will operate uninterrupted or error free.
The sole and exclusive remedy for a failure of QuarkXPress
to perform in accordance with the accompanying
documentation is for the Customer to return QuarkXPress to

Quark, Inc. and to notify Quark, Inc. in writing of |
nonperformance within ninety (90) days of purchase. Que
Inc.’s sole obligation shall be that within a reasonable ti
after receiving notification of nonperformance to prov
the customer with a performing copy of QuarkXPress.

7. DISCLAIMER OF OTHER WARRANTIES: T]
QUARKXPRESS LIMITED WARRANTY SET FORTH
PARAGRAPH 6 IS IN LIEU OF ANY OTH
WARRANTIES. THE IMPLIED WARRANTY ¢
MERCHANTABILITY IS LIMITED. QUARK, IN
DISCLAIMS ANY IMPLIED WARRANTY INCLUDIN
BUT NOT LIMITED TO, ANY IMPLIED WARRANTY
FITNESS FOR A PARTICULAR PURPOSE ¢
MERCHANTABILITY. QUARK, INC. DISCLAIMS A
WARRANTIES INCLUDING, BUT NOT LIMITED 'l
DISTRIBUTORS AND RETAILERS OF QUARK, IN
SOFTWARE.

8. OTHER WARRANTY RIGHTS: Some states do )
allow limitations on implied warranties so the abc
limitation may not apply to customer.

9. QUARKXPRESS UPDATES: At Quark, Inc.’s s
discretion Quark, Inc. may provide customer w
QuarkXPress updates. Quark, Inc. retains the right
provide the updates for a fee. Customer may refuse
accept the QuarkXPress updates.

10. CUSTOMER RESPONSIBILITY FOR SELECTION
QUARKXPRESS: Customer is solely responsible

selection of QuarkXPress to achieve the Custome
intended results or for particular applications.

11. DISCLAIMER: IN NO EVENT SHALL QUARK, It
BE LIABLE TO A CUSTOMER FOR ANY SPECI/
INDIRECT, INCIDENTAL OR CONSEQUENTI
DAMAGES IN ANY WAY RELATING TO THE USE
RISING OUT OF THE USE OF QUARKXPRESS. QUAI
INC.'S LIABILITY SHALL IN NO EVENT EXCEED T
TOTAL AMOUNT OF THE PURCHASE PRICE/LICEN
FEE ACTUALLY PAID BY THE CUSTOMER FOR THE L
OF QUARKXPRESS.

12. GREATER DAMAGE RIGHTS: Some states do
allow the exclusion or limitation of incidental
consequential damages so the limitation or exclus:
included in this License Agreement may not apply
particular customers.

13. GOVERNING LAW: This Agreement will be goven
by the laws of the State of Colorado.

Quark, Inc.
300 South Jackson St., Suite 100
Denver, CO 80209
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Introducing QuarkXPress

QuarkXPress 2.0 is a powerful electronic publishing tool which
allows you to integrate word processing, precision typesetting,
graphics manipulation, and page layout. Use QuarkXPress to
publish anything — from magazines to newspapers, books to
pamphlets, four-color advertisement layouts to product specifica-
tion sheets.

Word Processing. Word processing is an integral part of
QuarkXPress. It is powerful and easy to learn. Unlike most desk-
top publishing programs, users find it easier to write and edit text
directly in QuarkXPress, than to import text from a dedicated
word processor.

Precision Typography. Writing and editing words is one thing.
Making them look as though they are a well designed element of
the page is another. No other publishing program gives you as
many typographical features, with the level of control and preci-
sion available in QuarkXPress.

Page Layout. Page layout in QuarkXPress is highly precise and
flexible. Page elements such as text and graphics can be rear-
ranged and viewed on-screen until the desired design is achieved.
Design features such as Default Pages and Style Sheets serve to
automate the page production process, and make page layout
less tedious.

Graphics. QuarkXPress allows you to draw lines and generate
frames for pictures and columns of text. And, graphics can be
imported from most of the graphics and art programs for the
Macintosh. Depending upon the type of graphic, you may per-
form a number of stylistic manipulations.

Color. QuarkXPress has made color a truly useful design element
for desktop publishers. The program lets you create your own
colors. Or, if you prefer, spot colors can be selected from the wide
array of PANTONE®" Colors. Any color can be specified for text
and graphics created in QuarkXPress. The program can produce
process-quality separations of items to which color is added in
QuarkXPress.
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System Requirements

QuarkXPress 2.0 is designed to be used on a Macintosh Plus,
Macintosh SE or Macintosh II personal computer, with at least on
megabyte of RAM (Random Access Memory) and hard disk.
Quark, Inc. does not support use of QuarkXPress 2.0 on a
Macintosh 128, or any 512K computer system.

A Macintosh II and color monitor must be used to view the color
features of the program on-screen. Color can be defined and
applied when using a monochrome monitor, but results cannot be
seen on-screen.

To install QuarkXPress 2.0 onto your hard disk, consult the
Installation Tutorial in this chapter for specific instructions.

Due to the differences between the Macintosh Plus, Macintosh SE
and Macintosh II, you must install the Macintosh System soft
ware (necessary to operate the Macintosh) with an installer pro-
gram, rather than dragging the System to the hard drive to copy
it. Refer to your Macintosh Owner’s Guide, or ask your dealer if yot
have any questions about using an installer program to install
System software. Errors will occur when using QuarkXPress on

a computer whose System software was drag copied, rather

than installed.

What You Need to Know to Begin Learning
QuarkXPress

This manual and the accompanying reference material assume
basic Macintosh familiarity. Basic familiarity includes the informa
tion outlined in the Macintosh II, SE, and Plus Owner’s Guide. If
you are new to the Macintosh environment, we suggest that you
first examine the material which came with your Macintosh
before attempting to learn QuarkXPress.

The Building Blocks of QuarkXPress

QuarkXPress is box-based. Text is contained in text boxes; pic-
tures and other graphics, in picture boxes. Text boxes may be
drawn in picture boxes; picture boxes may be drawn in text
boxes. Lines drawn with QuarkXPress may be, but need not be,
drawn within a box.

INTRODUCTION TO QUARKXPRESS



Boxes and lines drawn inside a larger box are referred to as
“nested.” Nested items (boxes or lines) and the boxes in which
they are drawn have a “hierarchical” relationship. This means that
a nested item belongs to and is controlled by the box in which it is
drawn. That box is in turn subservient to the box in which it is
drawn, and so on.

This is the main textbox. It contains one picture box and another text
box. Boxes and lines drawn within a box are said to be child items of that
box. This textbox is the parent of all other items within it.

This textbox Is within the
The picture box below is a child of the mainimain textbox. It contains
text box. The picture box shown here a line as its child. This
contains a child text box. textbox is a child of
the main text box.
Butitis a parent
box of the

diagonal line.

This is a textbox
in a picture box.

It may be helpful to think of the hierarchical relationship between
nested items and the boxes they are drawn in as a parent-child
relationship. A box or line is a “child” of the box in which it is
drawn. A box containing another box or line is a “parent” to that
item. If you move, copy, cut, or delete a parent item, its children
will be moved, copied, cut, or deleted along with it. An item may
have more than one parent. A box may have more than one child.

For a complete introduction to the box-based structure of

QuarkXPress refer to the tutorial, Working with Boxes and Lines, in
this chapter.
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Filling Text Boxes

Text can be typed into a box using QuarkXPress word processing,
Or, text files may be imported into a text box, then formatted witl
QuarkXPress. (See Get Text under the File menu in the Reference
Manual for a listing of file types which may be imported by
QuarkXPress.) Once in QuarkXPress, formatting can be applied t«
text, regardless of where it originated.

Filling Picture Boxes

Picture boxes may be filled with either graphics from an art pro-
gram, or with electronically reproduced images from a scanning
device. In either case, imported files must be in one of the format:
QuarkXPress can use. (See Get Picture under the File menu in th
Reference Manual for a list of file formats compatible with
QuarkXPress.)

Linked Boxes

Too much text in a text box causes a text overflow condition. You
can control into which text box overflowed text is directed
through linking. Linking can be either automatic or manual,
depending upon the situation and your needs. To use
QuarkXPress most efficiently, it is most important that you gain
an understanding of how linking works. For this reason, a tutoric
dedicated to linking — both manual and automatic — has been
included in Chapter 2. (See also Using the Linking and Unlinking
Tools in the Reference Manual.)

Using the QuarkXPress Manuals

The QuarkXPress documentation is made up of two parts: the
pages contained within the three-ring binder, and the separately
bound Reference Manual.

This three-ring binder consists of four chapters:

The first chapter includes tutorials covering QuarkXPress installe
tion, working with boxes and lines, and word processing. The
tutorials in the second chapter cover text box linking, finding anc
changing text and text attributes, introductory typesetting with
QuarkXPress, and color manipulation.
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Chapter 3 contains information about how to use the Frame
Editor, a program included with QuarkXPress which allows you
to create and edit custom frames (borders) to place around text
and picture boxes. QuarkXPress includes a set of basic frames, but
the Frame Editor allows you to create your own frames which
may be used with QuarkXPress.

Chapter 4 presents an overview of typographical rules and con-
ventions, as well as instruction about how to implement some
popular design techniques using QuarkXPress.

The Reference Manual, the spiral-bound book you received with
the QuarkXPress package, provides a detailed description about
each of the QuarkXPress features and commands. The Reference
Manual is organized by menu. Menu entries are described in the
order they appear in their respective menus.

Using Menus

The menu bar located at the top of the screen contains the & menu,
and the seven QuarkXPress menus. The seven QuarkXPress
menus — File, Edit, Style, Item, Page, View, and Utilities — con-
tain menu entries which allow you to perform a command, or
cause a dialog box to be displayed. Menu commands cause an
action to be carried out on text, lines or pictures. Dialog boxes
allow you to communicate with the program — to enter measure-
ment specifications, to make selections, or to tell the program how
you want something modified. If a menu entry is dim (gray
instead of black when using a black-and-white monitor), that
menu entry is not currently available.

The illustration on the following page is an example of the Item
menu from QuarkXPress. The smaller menu toward the right of
the Item menu is the Default Line Width sub-menu, which is
accessed through the Item menu. Each of the menu parts is
labeled and described.

INTRODUCTION TO QUARKXPRESS 1-9



[ & Fite Edit style JJlEY Page view utilities

Dimmed Command

Modify... 8BM

Frame... ®B

Duplicate %D Menu

Menu Bar Step and Repeat...
Delete #¥K
Lock XL
Active Command §end Behing Keyboard Equivalent

Bring Foyward

Default Line WWidth id Other...

Hairline
v1pt

2 pt —m——

4 pt Checked

Commanc
Selected Menu Command  Sub-menu Indicator 6 pt ———

8 pt IEEE———
Sub-menu 12 pt I

Menu Bar — The menu bar is displayed at the top of the screen, and displays the name
of each QuarkXPress menu.

Menu - A menu contains menu entries grouped by the type of function they perform.
For example, the Item menu groups all the functions and dialog boxes related to modi
fying boxes and lines. Scroll up or down in the menu to highlight the desired menu
item, and release the mouse button to select it.

Active Command - A menu item which is available at the time the menu is accessed i
active (not dimmed).

Dimmed Command - If a menu item is not available when a menu is accessed, the
item name is dimmed, and cannot be selected.

Selected Command - A menu item on which the arrow pointer is placed becomes
highlighted, or selected. When you release the mouse button when a menu item is
selected, QuarkXPress will either perform a function or display a dialog box.

Checked Command — A check mark to the left of a menu command indicates that the
attribute or function is currently in effect.

Keyboard Equivalent — Keyboard equivalents allow you to access a menu item with-
out using a mouse. A keyboard equivalent will perform an action or call up a dialog
box, just as selecting the item with a mouse would.

Sub-menu Indicator — A triangle displayed to the right of the item name indicates thai
menu item has a sub-menu from which you can select choices.

Sub-menu - Sub-menus are extensions of a given menu item. A sub-menu provides a
list of choices related to the corresponding menu item from which to select. To display
the sub-menu, select the menu item and move the arrow pointer to the right. Scroll up
or down in the sub-menu to highlight the desired sub-menu item, and release the
mouse button to select it.
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Menu Commands

Menu commands allow you to perform some action. The example
below shows the QuarkXPress Style menu for text. Notice Size is
highlighted. The arrow to the right of Size indicates that this
menu command contains a sub-menu, from which you may select
a pre-defined font size. A menu entry followed by an ellipsis (...)
indicates that selecting that menu entry will cause a dialog box to
be displayed. For example, if you select Other... in the sub-menu
below, a dialog box will be displayed which allows you to specify
a font size by typing in the desired measurement.

. 0%\

Type Style
Color
Shade
Horiz Scale... v12 pt
Kern... 14 pt
Character... 0%D 18 pQ

24 ptt
Normal %N 36 pt
Alignment b| 48 pt
Leading... 0%E| 60 pt
Formats... O%RF| 72 pt
Tabs... 0%T
Style Sheets »

Notice how the 12 pt entry in the Size sub-menu has a check mark
to the left of it. The check mark indicates that the currently selected
text in the active document is 12-point text. The arrow pointer a
(which you move around the screen using the mouse) is pointing
to the 10 pt entry. If you were to release the mouse button with 10
pt selected — as is shown here — the selected text would be
changed to 10-point text. Changing font size using the point-and-
select method described here is an example of employing a menu
command to perform an action.
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A dialog box allows you to select options from lists, and to enter
measurements and other specifications. The Font size dialog box
shown below (Style > Size > Other) is one of the most simple
dialog boxes. It contains one field — Font size — into which you
may enter a desired size. Once a dialog box has been modified to
contain the data you desire, move the arrow pointer over the OK
button and click on the mouse button. Once OK is clicked, the
dialog box is closed, and the specifications you made (i.e., 10.5 pt
font size) are applied.

Font size:

P Other.. w# > - .
Type Style » 7pt
Color | Opt . '
Shade | 10 PR
Horiz Scale... 12 PR
Kern.., 14 me
Character... 0D 18 pQ

24 i

Normal OXN 36 pt
Alignment | 48 pt
Leading... OXE| 60 pt
Formats... OXF| 72 pt
Tabs... oRT
Style Sheets »

Keyboard Equivalents

Keyboard equivalents, such as “ D” next to the Duplicate entry
in the Item menu, are useful as short cuts to accessing menu
entries. (Throughout the manuals, keyboard equivalent characters
are separated by a hyphen, e.g., #-D. These hyphens are not part
of the keyboard equivalent; 32-D means press the the 3¢ key and
the D key at the same time.) By using a keyboard equivalent
instead of the mouse to select a menu entry, you can speed up the
process of making menu selections. Menu entries with corre-
sponding keyboard equivalents are labeled on the menu to the
right of the menu entry; not all menu entries have a keyboard
equivalent.

Keyboard equivalents are sometimes referred to as keyboard

commands. Appendix E in the Reference Manual lists all
QuarkXPress keyboard commands.
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Accessing the QuarkXPress Help File

The QuarkXPress help file, “XPress Help” is contained on the
Data Disk, which was included in this package. The help file pro-
vides a quick reference which you can display and read while

using QuarkXPress.
@— About QuarkHPress™ E
Getting Help
- Click Sequences
Key Sequences
The Tool Palette
Mover tool
Editing tool
QuarkHPress™ Creation tools
Linking & Unlinking tools
Uersion 2.0 Filomant
e
© 1986-88 Quark Inc. Open
Close
Save
Seve a3 O
G )

In order to use the help file, you must place a copy of XPress Help
into the same folder in which you store the QuarkXPress pro-
gram. Access the help file while in QuarkXPress by choosing
About QuarkXPress from the # menu. A dialog box is displayed
which contains a list of topics from which to choose. Use your
mouse to point to the topic of interest. Double-click on the desired
topic, or select a topic, then click Help. A help script about the
topic you selected is displayed. Cancel closes the help file, and
returns you to QuarkXPress.

When the help script is displayed, a new set of buttons is shown
at the bottom of the dialog box. Click on Topics to change topics.
Clicking Next displays the next topic of the help script; Previous
displays the previous topic of the help script. Clicking Cancel
closes the help file, and returns you to QuarkXPress. Use the
scroll bar to browse through the help script for a given topic.

P About QuarkHPress™ E——
New - Creates a new HPress document

Choose New to create 8 new XPress document. This brings up e
dialog box in which document attributes are specified

Page Size - the size of the document’s page. This can range from [
assmall a3 17 x 1", toas large as 48" x 48" g

US Letter = B 1/2" wide, 11" tall (preset option)
US Legal = 8 1/27 wide, 147 tall

Ad Letter = 210mm wide, 297mm tell

BS Letter = 182mm wide, 257mm tall

Tabloid = 11" wide, 177 tall

Other = 3ize specified by Width and Height

1Marging - the amount of spece between the edges of the paper and |
the text. Margins are preset to 1/2” on ell sides. Double Sided

m (Previous ] [ Cancel |
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QuarkXPress Tutorials —
Introduction

This chapter contains three tutorials: the first one helps you
install QuarkXPress; the second one covers the creation, resizing,
and movement of text boxes, picture boxes, and lines in
QuarkXPress; and the third tutorial introduces word processing
with QuarkXPress.

All tutorials assume familiarity with Macintosh use and con-
ventions, although some Macintosh concepts may be reviewed
in a tutorial. Each tutorial states the Prior Knowledge Required
prerequisites.

The introduction to each tutorial includes an Overview section,
which provides a view of the document you will construct or
states which QuarkXPress concepts and menu items are covered
in the tutorial.

Most documents prepared in the tutorials require the use of text
and pictures from either Sample Disk 1 or Sample Disk 2.

Under the heading Reference Manual, the tutorial introduction
lists the relevant sections of the Reference Manual that you may
find helpful to read before taking the tutorial. You will obtain
the most benefit from a tutorial if you read the Reference Manual
sections first.

Individual steps (actions) in the tutorial are numbered and bold-
faced. Please read an entire numbered step before taking any
action. Results of actions and explanations are in plain text. In
most tutorials, groups of steps related to a specific goal will be
listed under a heading describing that goal.

The number for the last step in a tutorial appears in outline type

style. Be sure to save your work if you must quit before the end o
the tutorial.
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Installation Tutorial

Overview: Your QuarkXPress package should contain four disks:
the Program Disk, the Data Disk, Sample Disk 1, and Sample Disk 2.

The disks are shipped unlocked. To avoid accidental deletions or
write-ons, lock the QuarkXPress Data Disk and the QuarkXPress
Program Disk by moving the small black tab so that you can see
through the hole.

T |" <®—— You can see through this hole
t —| when the disk is locked.

A locked disk can still be copied, so locking will not interfere with
QuarkXPress installation.

Prior Knowledge Required: Many of the terms and procedures
used in this and following tutorials assume a basic familiarity
with the Macintosh. If you have not already done so, we strongly
recommend that you take the Apple Tour of the Macintosh or read
the introductory material in your Macintosh manual before proceeding.

Follow the steps below to install QuarkXPress on your hard drive.

1. Turn on your Macintosh, and when you are at the Finder,
open your hard disk by double clicking on its icon.

2. Create a new folder by selecting New Folder from the File
menu in the Finder. Name the folder “QuarkXPress™.

3. Insert the QuarkXPress Program Disk. To open the disk,
double click on the QuarkXPress disk icon when it
appears on your desktop. If necessary, drag the disk
window aside to expose your hard drive window contain-
ing the new QuarkXPress folder.

4. Drag the QuarkXPress program from the Program Disk
into the folder you created. When the copying is com-
plete, close the Program Disk window and eject the
Program Disk.

5. Insert the QuarkXPress Data Disk. When the disk icon

appears on your Finder, double click on the icon to open
the Data Disk.
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6. Drag the contents of the Data Disk to the Quark XPress
folder to copy them. The Data Disk contains: XPress Data
XPress Help, XPress Dictionary, XPress Hyphenation,
WriteNow Filter, MacWrite Filter, Microsoft Word Filter, Frame
Editor, and Frame Editor Help. Hold down the Shift key to
copy several items at once or choose Select All from the
Edit menu. When the copying is complete, close the Data
Disk window and eject the Data Disk.

QuarkXPress is now installed on your system. To access the pro-
gram, double-click on the XPress application icon.

Until you return your Warranty Registration Card and receive your
personalized version of QuarkXPress, you will have to use the
Program Disk as a key to access the program for each session. The
computer will prompt you to enter the disk when you double
click on the XPress icon.

Note that for QuarkXPress to find the dictionary, help files, and
Frame Editor, all files must be in the same folder.
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Tutorial: Working With Boxes and
Lines

Overview: This tutorial is an introduction to the fundamental
design element in QuarkXPress — the box. You will use the tool
palette and keyboard commands to create, move, resize, and
delete boxes.

You will also learn to create, move, resize, and delete lines.

Following the box and line discussions, you will work with a pic-
ture imported from Sample Disk 2.

Prior Knowledge Required: It is assumed that you are familiar
with your Macintosh. You should be able to use the mouse and
scroll boxes.

It is also assumed that you have taken the QuarkXPress installa-
tion tutorial and that you are currently in the Finder.

Reference Manual: You will obtain the most benefit from this
tutorial if you first read the following discussions in the introduc-
tion section of the Reference Manual before proceeding: The Tool
Palette, Boxes, and Lines.

QuarkXPress Tools

The QuarkXPress tools that are used to create and work with lines
and boxes are reviewed in this section preceding the tutorial.

Text boxes are created using the @ tool. A text box is a box which
will contain text that is typed into it or imported into it from
another source. A text box can also contain lines, picture boxes,
and other text boxes.

Picture boxes are created using any of the picture box creation
tools, ®, ®, ®. Picture boxes can also contain lines, text boxes,

and other picture boxes.

A box that contains other boxes or lines is called a parent box. The
boxes and lines created within it are called child boxes and lines.
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Lines are created using any of the four tools, +, \, \, or . The
line creation tools have many of the same characteristics as the
box creation tools.

The arrow pointer k performs many different functions, and
changes in appearance depending on what is being done. It may
appear as:

4 (the mover pointer) when the mover tool is selected and the
pointer is brought within an active box or placed on any
active line.

<8 (the resizing pointer) when the pointer is placed onto a han-
dle of an active box or line.

+ (the box/line creation crosshair pointer) when a text box, pic-
ture box, or line creation tool is selected and the pointer is
brought within an active box; when you hold the mouse butto
down with one of the creation tools selected; when a creation
tool is selected and there are no active items in the document.

I (theI-beam pointer) when the editing tool is selected and the
pointer is within an active text box.

When a line, text box, or picture box is active (has handles on it), :
can be resized with the resizing pointer <& or moved with the
mover tool «.

Working With Boxes

Before starting this tutorial, insert Sample Disk 2 into your floppy
disk drive (it contains a picture that you will use later) and click
on the disk icon to open it. Drag the folders Chap.1 Picts and
Chap. 2 Picts onto your hard drive to copy them. From your
Finder, open the QuarkXPress folder on your hard disk and dou-
ble click on the XPress application to open the program.

Creating the Initial Text Box

1. From the File menu, select New.
2. In the New dialog box, click OK.

This brings up the first page of the new document. The first page
of the document contains one 7.5" x 10" text box (as determined b
the default margin settings in the New dialog box). Any items
drawn in this 7.5" x 10" box will be children of this box.
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3. Select the text box creation tool @ from the tool palette
and bring the pointer back into the document.

Notice that the arrow pointer changes to a crosshair when
brought into the document.

4. Position the crosshair pointer inside the large box on your
screen, near the upper-left corner of the text box.
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5. Hold down the mouse button and drag downward diago-

nally to your right. (Notice the dotted lines in the rulers that
identify the four corners of the box when you press the
mouse button and begin drawing your box.) After creating
a box roughly 2 inches by 2 inches, release the

mouse button.

Your screen should look something like this:
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Note that this new box is a child of the 7.5" x 10" text box.
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For the next step you will hold the Option key while selecting the
text box creation tool. Pressing the Option key keeps the tool
selected until you select another tool.

6. Hold down the Option key and select the text box cre-
ation tool. Release the key after the tool is selected.

7. Draw a few more text boxes outside the 2" x 2" box. For
at least one of these boxes, press the Shift key while yo1
draw. This constrains the box to a square.

Notice that the arrow pointer turns into a crosshair pointer when
it is within an active text box. When the crosshair pointer is
moved outside an active text box, the arrow pointer reappears.

Moving a Box

8. Select the mover tool % from the tool palette and bring
the cursor into whichever newly-created box is active.

Notice that the pointer changes to the mover pointer «.

9. Hold down the mouse button and drag the pointer (with-
in the smaller box) around in the visible portion of your
document (if you are using a Macintosh SE-size screen).
Try to move the box out of the larger page text box.

You will notice that the box you created cannot be moved outside
the larger 7.5" by 10" text box. (If you try, the shadowed box indi-
cating the new position disappears when you move the pointer fa:
enough outside the box.) This is because the smaller box is a
“child” of the larger box. In QuarkXPress, boxes are “nested” with
in one another according to the order in which they are created.

On Macintosh SE-size monitors, moving the box into parts of the
document that do not show in the document window brings thos
areas into view, in effect forcing the document to scroll.

You will now create a box within the 2" x 2" box.

10. Select the text box creation tool from the palette. Move
the pointer within the 2" x 2" box.

11. Hold down the mouse button and drag out a roughly
half-inch by half-inch box within the 2" x 2" box.
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When you release the mouse button (having completed your box),
the previously selected tool, which in this case was the mover
tool, is automatically reselected in the palette.

12. Move the small box around in its parent.
You will now move the parent and child together.

13. Click outside the small box, but inside its parent. This
activates the parent box.

14. With the mover tool still selected, press the mouse but-
ton and drag the 2" x 2" box to a new position.

Notice that the smaller box retains its position within its parent
box regardless of the parent’s location.

Resizing a Box

15. Select the editing tool ™ and check that the 2" x 2" box
is activated. Move the pointer into the active box.

Notice that the pointer changes to the I-beam pointer Y when in an
active text box with the editing tool selected.

16. Move the pointer onto one of the box handles until it
changes into the resizing pointer .

17. With this pointer showing, hold down the mouse button
and drag in any direction.

Notice that the box can be made any size, and that if you grab
a corner handle, the corner diagonally across from the handle
you are holding remains anchored. Grabbing a middle handle
will constrain the box resizing in that direction (up, down, left,
or right).

The only restriction on box resizing is that a parent box cannot be
resized to the point where it cannot hold its child.

Experiment with resizing the box using both the corner and
side handles.
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Cutting and Pasting Boxes

18. Select the mover tool and activate the small child box;
select Cut from the Edit menu.

The small box has been deleted. This action can be undone using
the Undo command in the Edit menu.

19. From the Edit menu, select Undo Item Deletion.
The small box reappears in its previous location.

You will now delete the larger box and see that deletion of a par-
ent box deletes all child items.

20. With the mover tool still selected, activate the parent bo)
and delete it using Cut from the Edit menu. You will be
warned that the action will delete several items and can-
not be undone.

21. Click OK.

While this action cannot be undone, the deleted parent and child
items can be pasted back into the document.
22. Select Paste from the Edit menu.

The items are now in the center of the document window. You
will now delete them again.

Deleting Boxes

23. Select the mover tool and press Delete. Click OK in the
warning dialog box.

24. With the mover tool selected, use the Delete key to
remove all remaining boxes from your document except
the original 7.5" x 10" text box.

Working With Lines

Lines are created using any of the four line creation tools in the
palette (4, X, =, \\). While lines can be children of a box, a line
cannot be a parent of any other item.

A line originating within a box cannot extend beyond that

box; also, a child line is moved and /or deleted along with its
parent box.
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Creating Lines
You will now draw, move, resize, and delete lines.
25. Draw another 2" x 2" text box.

You will draw three lines in this exercise. You will use the arrow
creation tool X to draw a line originating outside the small box
and ending inside. This will help you remember the line’s origin.
You will use the orthogonal line creation tool + to draw a vertical
line outside the 2" x 2" box, and you will use the line creation tool
\ to draw a line totally within the small box.

26. Select the arrow creation tool ~ and move the pointer
about an inch from the small box but within the original
7.5" x 10" text box.

27. Hold down the mouse button and drag the line until it
crosses the border of the smaller box. Release the
mouse button.

The line will blink once and then show with handles at each end.

28. Select the orthogonal line creation tool +, and draw a
vertical line to the right of the 2" by 2" box.

You will now use the Shift key to constrain a line to 45 degrees.
The Shift key will constrain the line to 0 degrees, 45 degrees,
or 90 degrees.

29. Select the line creation tool \, hold down the Shift key,
and draw a short line completely within the small box.

Your screen should look something like this.
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Moving Lines

30. With the mover tool selected, move the pointer onto
the vertical line and click. (If, after clicking, the handles are
not displayed at the ends of your line, you probably missed —
try again.)
(This exercise is best done with the mover tool selected. If the edit
ing tool is selected and you miss the line and activate the box, the
line is sent behind the box to facilitate text editing. This can cause
problems if you are interested in working with lines rather than
editing text.)

31. With the line active and the mover pointer 4 on it, hold
down the mouse button and drag the line.

The line can be moved anywhere but outside its parent.

Resizing Lines

32. Use the pointer to click on the arrowhead line going into
the box.

33. When the handles appear, move the pointer onto the
handle on the head of the arrow.

The pointer changes to the resizing pointer .

34. With the resizing pointer showing, hold down the mouse
button and resize the line in any way you want.

Notice that while the angle and length of the line can be altered,
one end is always anchored.

Deleting Lines

35. Again, with the mover tool selected, activate the vertical
line.

36. Press 3-K to remove the line.

Such deletions can be undone using Undo from the Edit menu.

38K is the keyboard equivalent for the Item menu command
Delete.
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37. Delete all items on the page using :z-K. (If you accidental-
ly activate the 7.5" x 10" text box and press Delete, you will
get a warning dialog box. Click Cancel.)

Working With Picture Boxes

Picture boxes are created, moved, and deleted much the same as
text boxes. Picture boxes have three pre-defined shapes — @, ®,
and ® — from which to choose.

38. Select the rectangle picture box creation tool x from the
tool palette.

You will use the Shift key to constrain the box to a square.

39. Holding down the Shift key, create a square picture box

measuring about 3" by 3" in the upper-left corner of the
original 7.5" x 10" text box.
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Similarly, you can constrain a picture box to a perfect circle by
holding the Shift key while drawing with the oval picture box cre-
ation tool ®.

40. Select the ® tool from the palette.

41. Holding down the Shift key, drag out a circular picture
box roughly 2" in diameter.

42. Delete the circular box by selecting the mover tool and
pressing the Delete key.
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Importing a Picture
In this section you will import a picture into a picture box.
43. Select the editing tool from the palette.
44. Activate the square picture box you created earlier.
45. From the File menu, select Get Picture.

46. After the Get Picture dialog box appears, open the Chap.
1 Pict folder to get to Box Sample TIFF.

Get Picture

&3 Chap. 1 Pict
BTG, < hord disk

47. Open the document called Box Sample TIFF.

You are returned to the document. After a few moments you will
see a part of a TIFF (Tag Image File Format) picture of a balloon a
shown below.
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Positioning a Picture

48. Making sure that the editing tool is selected, move the
pointer into the active picture box and watch it change to
the picture-moving pointer .

Using this pointer you can position the graphic within the box.
While you keep the mouse button pressed, you can move the {%
both within and outside the picture box to better position

the image.

49. With the ™ showing, hold the mouse button and drag
the picture around in the picture box. (There may be a
brief wait for the hand to “grab onto” the image.) Move
the (™ outside the box. When finished, leave the balloon
off center.

50. Press -Shift-M.

This command centers the picture in the middle of the box. You
see all of the picture that will fit centered in the picture box.

You will now use two other keyboard commands for centering
graphics. The first fits a graphic entirely within the picture box,
but may cause distortion in doing so.

51. Press -Shift-F.

Your screen should look something like this. Notice that the pic-
ture is distorted horizontally.
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The next keyboard command proportionally scales the graphic so it
will fit within a given picture box without distortion. Depending
on the picture imported, there may be excess white space at the
bottom or to the right of the image.

52. Press 3-Option-Shift-F.

The scaled-down balloon will be at the left of the picture box.

53. Center the balloon, using s-Shift-M.

Resizing the Picture Box

54. Resize the picture box by dragging on the handles.

Notice that when you resize a box containing a picture, the picture
is unaffected.

Resizing the Picture

You will now use keyboard commands to resize the picture in
5% increments.

55. Making sure that the editing tool is selected, increase
the size of the picture by holding s¢-Option-Shift and
pressing > twice.

This increases the picture size 10%. The picture blinks as it
is resized.

56. Reduce the picture size by holding 3-Option-Shift and
pressing < three times.

This concludes the Working With Boxes and Lines tutorial. Close the
document, saving or not as you wish.
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Tutorial: Word Processing

Overview: This tutorial is an introduction to word processing
with QuarkXPress. You will compose the letter shown at the end
of this section by typing some of the text and bringing in the
heading and body of the letter from Sample Disk 1.

In this tutorial you will copy two folders containing sample text
for this and other tutorials from Sample Disk 1 by dragging them
onto your hard drive.

If you are an experienced Macintosh user and familiar with other
word processing programs, you may want to skip this elemen-
tary-level tutorial and begin working with the advanced tutorials
in Chapter 2, after you have worked through the Installation tuto-
rial and the Working With Boxes and Lines tutorial.

Prior Knowledge Required: It is assumed that you can type and
are familiar with your Macintosh computer and the use of the
mouse. You must have taken the Apple Tour of the Macintosh that
came with your Macintosh or have read the equivalent section in
the Macintosh manual.

It is also assumed that you have read the introduction to the
QuarkXPress manual, have gone through the tutorial on installing
QuarkXPress and the one on creating boxes and lines, that the
program is installed on your Macintosh, and that you are in the
Finder, ready to begin this tutorial.

Reference Manual: You may want to read the discussions in the
reference manual related to the following menu items; the menu
name is listed first, followed by the menu item or specific section
under that item.

File menu: New, Get Text

Edit menu: Copy, Paste, Select All

Style menu: Font, Size, Alignment

View menu: Fit in Window, Show/Hide Invisibles.
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Sample: A scaled down sample of the letter you will compose is
shown below.

P D L O PR . bl BT O DA A ML b
‘-n-nn.n- AP IS . o8

T4 T _m;;--

ko

et Laa

Bring in Sample Text

Before starting this tutorial, insert Sample Disk 1 into your floppy
disk drive (it contains text for this and other tutorials) and click
on the disk icon to open it. Drag the folders Chap. 1 Text and
Chap. 2 Text onto your hard drive to copy them.

Begin Word Processing Tutorial

As stated above, you should be in the Finder, ready for the
first step.

1. Double click on your hard drive to open it. Double click
to open the QuarkXPress folder. Double click on the
XPress program icon to open the program.

The QuarkXPress logo will be displayed briefly; then the menu
bar for QuarkXPress will be displayed across the top of the screen

2. Open the File menu and choose New.
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Defining the Initial Page with the New Dialog Box

The New dialog box will come on screen. You will leave Page
Size and Page Guidelines set to the QuarkXPress defaults. You
will change the Margins so that a line of text in the letter you
compose is short enough to be seen on a Macintosh SE-size moni-
tor without right-to-left scrolling.

New
~Page Size ~Page Guidelines

@ US Letter QO R4Lletter O Tabloid .
OusLegal OB5Letter O Other Columns: [:

width: Height: [11- | Gutter widtn:[0.167" |

~Margins
Top: 0.5 Left: 0.5"
Bottom: [0.5" Right: (0.5 [ ok J] (cancer)

[J Double Sided

3. Notice that the Width field is highlighted. Press the Tab
key to move the highlighting to the Height field, and
again to highlight the Top margin field.

4. Type “1” in the Top margin field.
You have set the top margin at one inch. Inches are the default

measurement for QuarkXPress.

5. Press the Tab key to highlight the Bottom margin box.
Type “1” in this field.

6. Press the Tab key again to highlight the Left margin field
and enter “1.5” in this field.

7. Press the Tab key once more to highlight the Right mar-
gin field and enter “1.5” for the right margin.

8. Press the Return key (or click OK).

The New dialog box will close and the initial page will be dis-
played. The page will contain a text box having the dimensions as
specified in the New dialog box (in Margins). The text box
appears as the dotted-line box on the page.
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The tool palette will show the editing tool J{" selected.
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Typing the Letterhead

9. Use the scroll arrows in the horizontal scroll bar to cen-
ter the text box in the document window.
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(Place the arrow pointer on the rightmost scroll arrow ir
the horizontal scroll bar at the bottom of the window.
Click on the scroll arrow about five times to center the
left and right edges of the text box on your screen.)

The top part and entire width of the text box you specified in Ne
should be visible.
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10. Click inside the text box outline to activate the text box.

The blinking text insertion bar will appear in the upper left corner
of the text box.

11. Type the return address shown below. Press the Return
key at the end of each line. If you make a mistake, go
immediately to the next step to find out how to correct
your mistake, then resume this step.

Herbmaster, Inc. [Return]
1234 Garden Avenue [Return]
Denver, Colorado 80206 [Return]

Pressing the Return key moves the text insertion bar down one line.

How to Correct a Typing Error

12. If you make a typing error, you can correct the error in
the following way:

Place the text insertion bar to the right of the incorrect
character (move the I-beam ] to the desired location)
and click.

The blinking text insertion bar will be displayed. If the text inser-
tion bar appears in the line above the one you wanted it in, try
again. Take care that the top of the I-beam pointer is not catching
on the upper line and causing the insertion at that point.

When you have placed the text insertion bar to the right
of the incorrect character(s), press the Delete key to
erase the incorrect letter(s). The Delete key deletes one
character or space at a time.

Type the correct letter(s) or move the text insertion bar,
then type, as required.

Pressing the Delete key erases the character to the left of the
insertion bar. To Delete the character to the right of the insertion
bar, hold down the Shift key and then press the Delete key. You
may wish to try this second method also.
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Centering the Letterhead

Do not start this section until you have typed the
letterhead correctly.

13. Press the Return key after typing the last line of the let-
terhead, if you have not already done so.

The insertion bar is now at the left margin.
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Now you will center the return address information as a letter-
head and change the text font size and type style.

14. Go to Edit and choose Select All.

All the text is now highlighted.

15. Go to the Style menu and scroll down to Alignment. Note

that Alignment has an arrowhead mark to the right; this
indicates that a sub-menu is available for this commanc

16. Move the pointer to the right into the sub-menu and
select (highlight) Centered. Release the mouse button.

The menu will close. The highlighted text will now be centered a
the top of the page.

INTRODUCTION TO QUARKXPRESS



Changing Font Size and Type Style

17. Go to the Style menu and scroll down to Size. Move
across to the sub-menu and select 18 pt.

The menu will close. The highlighted text is now 18-point font size.

18. Go to the Style menu, scroll to Type Style and select Bold
from the sub-menu.

The highlighted text is now in Bold type style.

19. Click anywhere in the text box, below the selected text,
to deselect the letterhead.

The text is no longer highlighted. Notice that the text insertion bar
appears centered underneath the return address.

Inserting the Date for the Letter

The next step will move the text insertion bar back to the left mar-
gin to place the date for the letter.

20. Go to the Style menu again. Scroll to Alignment and note
that Centered, the present letterhead alignment, is
checked. Choose Left.

The text insertion bar is now at the left margin. The date, the
inside address, and greeting for this letter will be aligned left and

a few lines below the letterhead.

21. Press the Return key two times to place the text inser-
tion bar where the date will be inserted.

22. Type today’s date. See step 12 above for correcting mis-
takes, if necessary.
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Changing Font Size and Type Style for the Date

The font size used in the letterhead has remained selected. It is to
large for the rest of the letter. The next step is to change font size.

23. Select the date by dragging the I-beam pointer across it
The date is highlighted.

24. Go to the Style menu. Scroll to Size and select 12 pt fron
the sub-menu.

The date has been changed from 18-point font size to 12-point fo
size. Next you will change the type style.

25. Go to Style; scroll to Type Style. Notice that Bold is
checked. Select Plain.

The date is displayed in Plain text. Deselect the date by clicking
anywhere inside the active text box.

Bringing in Text for the Letter with Get Text

First you will place the text insertion bar where you want the
imported text to be displayed.

26. Place the text insertion bar at the end of the date line,
then press Return four times to lower the text insertion
bar for typing the address of the person to whom the
letter is written.

For this part of the letter you will bring in text you previously
imported from Sample Disk 1. If you have not already brought
these documents onto your hard disk, please go back to the intr¢
duction of this tutorial for instructions.

27. Go to the File menu and choose Get Text.
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28. After opening the folder Chap.1 Text, Open the document
called WP Sample Text.

Get Text

3 Chap. 1 Text

@ hard disk

Drive

O Include Style Sheets

The text for the inside address, greeting, body, and closing of the
letter has now been placed below the date. Scroll up and down
through the document to see all of the text you brought in.

Working with Invisibles Showing

Next you will format the letter. This will be done with invisibles
showing. Invisibles are special characters that tell you a certain
key was depressed, or a certain action was specified that affects
text formatting.

29. Go to the View menu and choose Show Invisibles.

The invisibles that show in this document are symbols for returns
and space. Notice that the dots representing spaces are placed
higher than those for periods, which are placed at baseline level. It
is easier to format text when the invisibles are showing.

=== Documentl
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N Denver, Colorado 80206
Space N
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Page 1
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Changing the Font of the Imported Text

Notice that the font in the letter is different from that used for the
date and return address. You will now make all text the same fon

First you will find out the name of the font used in the body of
the letter.

30. Place the text insertion bar in the body of the letter that
you have just obtained with Get text. (Place the I-beam
and click; the text insertion bar will be displayed.)

31. Go to Style and select Font. Notice that Chicago is checked

You will usually want to use the same font for an entire letter. We
have arbitrarily decided to match the font used in the body of the
letter to that used for the letterhead and date.

First you will find out which font is used in the date you typed al
the top of the letter, then you will change the font for the body of
the letter.

32. Click on the scroll arrow at the top of the vertical scroll
bar (on the right side of the document window) to reach
the date toward the top of the letter.

33. Place the text insertion bar anywhere in the date. (Place
the I-beam and click; the text insertion bar will be dis-
played.)

34. Go to Style and look at Font. Note the font name that is
checked — Helvetica.

35. Change all the imported text in Chicago font to Helvetica.
Use the prompts below if you are uncertain how to do thi:

a. Select the text to be changed. (Drag the I-beam
across the text to select it.)

b. Go to Style, choose Font, and select Helvetica from
the sub-menu.

c. Deselect the text by clicking.

The body of the letter is now the same font and font size as
the date.
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Formatting the Body of the Letter

Next you will divide the letter into paragraphs and place the
letter closing.

36. Place two returns after the second sentence. (Look for
the parentheses enclosing the bold text “Place two
returns here.” Place the returns before the bold text in
parentheses.)

The new paragraph should begin with “(Place two returns here.)
I have included our most...”

37. Highlight the bold-faced text in parentheses that pre-
cedes the new paragraph, including the parentheses and
invisibles for spaces, and then press Delete.

38. Format another paragraph by placing two returns at the
next location specified by bold-faced text in parentheses.

The new paragraph starts with “(Place two returns here. ) The
HerbMaster 5000 has ...”

39. Delete the bold-faced text that marked the insertion point
for Return placement.

40. Place the next four sets of returns indicated and delete
the bold-faced text after you have placed each set
of returns.

The letter has now been formatted so that it resembles the one in
the overview.

DI ——— |
u.zl.ul.1.311111.1.1.1.1.1‘51.1.l.lﬂu.lu. .1.!.1.‘1111
L3 )amen gp g

]
=

?

DearMs Public
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he back of ha enclosed brochure,

[The HebMaster S000 has builtin LeslLopping - - sllowing you to trim
[Vour tanag on, raze Your rosemary, cut your chamomile or saw your sage
in no angane !

|Thanks agen for your interest in H erb Master products

Yery truly yours,

Gl BEREEEER

C TR TN T TN TR

|Gregory Park File
Conaum er mask
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Editing the Letter
The next steps involve editing the letter.

41. Scroll up to the top of the letter. It is addressed to
“Ms. Jane Q. Public”.

42. Highlight the greeting and substitute your name. As
soon as you start typing, the highlighted material is
deleted. It is not necessary to use the Delete key to cleai
highlighted material before typing the replacement text.

Using Copy and Paste to Edit

Next we will use Copy and Paste to reverse the order of the sec-
ond and third paragraphs so the letter will make better sense.

43. Highlight the third paragraph by placing the |-beam to the
left of the line beginning “The Herbmaster...” and draggin
through “... thyme!” (include the Return character at the
end of the paragraph). Go to Edit and select Copy.

The paragraph has been copied to the Clipboard. It can now

be deleted.

44, Press Delete to eliminate the paragraph you have just
highlighted and copied.

The paragraph is no longer displayed on the page. Now you wil

paste it in a new location.

45. Place the text insertion point in front of the Return char-
acter beneath the first paragraph. Press Return once to
move the text insertion point.

This is the point where we wish to insert the copied paragraph
waiting on the Clipboard.

46. Go to Edit and choose Paste.
The copied paragraph is now in the right location.
More Editing

The next editing task is to change the typewriter-style dash to a
typesetter’s dash.
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47. Find the double hyphen dash (- -) in the second para-
graph — the paragraph you just pasted into place.
Highlight the two hyphens. Replace them with a typeset-
ter’s dash by holding down the Shift key and the Option
key at the same time and depressing the hyphen key.
Leave a space on either side of the dash.

The keyboard sequence for accessing the dash is written:
Option-Shift-hyphen

For your typesetting to have a professional appearance, it is
important to use this long dash — rather than the double hyphen
usually learned in typewriting classes.

48. In the last sentence of the body of the letter, delete the
space between the two syllables of the word HerbMaster.

(This exercise clearly exemplifies the usefulness of the invisible
characters in editing text.)

49. In the first paragraph, change the type style on the num-
ber “5000” from italic to plain text. (Highlight the number,
go to the Type Style sub-menu of the Style menu and
select Plain.)

Leaf Lopping (in the second paragraph) is a trademarked item. The
following step adds a small “TM” to Leaf Lopping.

$0. Place the text insertion bar after the g of Leaf Lopping. Go
to the Style menu and select Superior from the Type Style
sub-menu. Type “TM”.

The “TM” you typed should look like this:
Leaf Lopping™

You have completed the word processing tutorial. If you wish,
you may edit the letter further to practice your skills.

You should now feel comfortable moving the text insertion bar,
correcting typing errors, changing font, font size and type styles,
using the Return key to start new paragraphs, selecting alignment
for text, using a typesetter’s dash, creating superior characters,
and using Copy and Paste to move text around.
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Introduction

This chapter contains four tutorials which introduce some of
QuarkXPress’ text management functions. The first tutorial covers
manual and automatic linking of text boxes, the second covers
finding and changing text and text attributes, the third is an intro-
duction to typesetting with QuarkXPress, and the fourth intro-
duces you to QuarkXPress’ color capabilities through the produc-
tion of a mock magazine cover.

If you have not worked through any of the tutorials in the first
chapter, you will find it helpful to read the introductory material
in QuarkXPress Tutorials to familiarize yourself with some of the
conventions found in the following tutorials.

As is pointed out at the beginning of each tutorial, it is strongly
recommended that you read the relevant section(s) of the
Reference Manual before working through the tutorial.

The sample documents and pictures used with the exercises in
this chapter are contained in Sample Disk 1 and Sample Disk 2.
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iutorial. LIinkin |lexXlt boxes

Overview: The fundamental layout unit of QuarkXPress is the
box. Linking is the method by which QuarkXPress connects boxes
containing text to allow for greater ease of page layout. Automatic
linking connects overflow text from one text box to a specified text
box on a newly inserted page.

In this tutorial you will go to a document’s default page and view
the links that are set up automatically in all QuarkXPress docu-
ments. You will also change the automatic text chain, and in
another section manually link two boxes.

The default page is a non-printing page on which links and basic
page formatting are established. Changes made to the default
page of a document affect all pages created after the default page
was modified.

Reference Manual: To fully understand the concepts involved in
linking, it is strongly recommended that you read the following
sections of the Reference Manual:

Introduction: Using the Linking and Unlinking Tools
File menu: Get Text
View menu: Show/Hide Default

It is also recommended that you take the box creation tutorial
in the previous chapter if you are unfamiliar with this Quark
XPress feature.

The following tutorial will help you understand linking as
defined automatically by the default page, or as you define it
manually yourself. In the tutorial you will establish links, break
links, establish page numbers using the default page, and modify
the default page of a document you will create.

The sample text for this tutorial was drag-copied at the same time
as that for the Word Processing tutorial. If you did not take the
Word Processing tutorial, please read its introductory comments for
directions on dragging the sample folders onto your hard disk.
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In Linki ng lutoria

In the Finder, open the QuarkXPress folder on your hard disk an
double click on the XPress application. This opens the program.

Viewing the Automatic Link

1. Create a new document by selecting New from the
File menu.

2. Set the Width of the page at 6 inches and the Height at
4 inches.

3. Press Return (or click OK).

This brings up the first page of the new document. (This page
size has been selected for the sake of convenience — you should
be able to see the whole page on a Macintosh-SE size monitor
without scrolling.)

You are now going to the default page. Do not activate the box.

4. Select Show Default from the View menu.

The new page in your document window looks exactly like
page 1, but contains an icon in the upper-left corner called the
intact chain icon @. This, combined with the word Default in the
lower-left corner next to the scroll bar, tells you that you are on
the default page.

5. Todisplay the default link that QuarkXPress sets up for
text boxes, select the linking tool @ from the tool palette
and click on the intact chain icon @ in the upper left cor
ner of the document window.

6. From the View menu, select a view of 200%.

In the enlarged view, you will see a small arrow connecting the
marqueed icon box with the main text box. (The moving dashed
line surrounding the icon box is called a marquee.) The icon box
can be thought of as the first box in the linked chain.
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A marqueed box is the active box in a linked chain when the link-
ing tool is selected.

Document!

EEEEEED 5

i

EH-

7. Select Actual Size from the View menu.

8. Click on the text box creation tool @ to deselect the
linking tool.

Page Numbering

One important use for the default page is to establish printed
page numbers for each page. To establish such numbers, work
through the following steps.

(If you have not taken the Working With Boxes and Lines tutorial,
and are unfamiliar with creating text boxes, please work through
that tutorial before continuing.)

9. Using the text box creation tool, draw a box roughly one-
half inch high by one inch wide within the default text box.
The box should be flush against the bottom of the
default text box and roughly centered. (See the illustra-
tion on the next page.)
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Document1
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Default Kal

10. Type -3 in this box. (Hold down the 3z key and type a 3.
Notice that the character <#> shows on the screen.

This is called the current box page number character. With this
character on your default page, QuarkXPress will automatically
insert the current page number at the bottom of every page of
your document.

You will now center the number in the box.

11. Under the Style menu, select Centered from the Alignmen
sub-menu.

12. Select Hide Default from the View menu.

This returns you to the first page of the document. Notice the cur-
rent page number at the bottom of the page.

Automatic Linking

To see the effects of automatic linking, you will bring in a block of
text which is large enough to overflow from the first page, forcing
the creation of a second page for the excess text.

13. Click inside the large text box on the first page to
activate it.
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14. Select Get Text from the File menu. Ignore the Include
Style Sheets option.

[ Document

= T r— | P PR TR

Get Texnt

vy ] = & Linking Tutorial Semples | -
x| 3 ©herd disk =
X |17 D Linking Tutorial Text 2
@] ] D Linking Tutorial Text 3
E3g
e :
T -.
) (Concel {
!!J: [J Include Styte Sheets h
Page 1 Ka % il

15. Open the folder Linking Tutorial Samples and Open the file
called Linking Tutorial Text 1.

The document you created will reappear on the screen filled with
the imported text. Because there was more text than the first page
could hold, a second page was created.

If you are working on an Macintosh SE-size monitor, you are cur-
rently viewing Page 2. (Notice the page number in the lower-left
corner of the document window.)

16. Scroll to the top of Page 1.
Read the first paragraph — the text starts with “Linking is...”
17. Scroll the document until the page separation bar

between Pages 1 and 2 is roughly centered in your docu-
ment window. See the illustration below.

Linking is a method whereby text is alloved to flow from one box to
lanother. When the lirking tool is selected from the tool pakette, and
[lan active box is part ofa T

linked chain, you will see i

" fhe arrows that indrate which boxes comprise the chain These
larrows also represent the direction that linking Is taking, such as
from page 1to page 2. These arows do ot print. They also do not
Ishow up on the screen when any tools other than the linking and
unlirking tools are selected.

|,»g;|g|.z'|/'E/|+|®|®IEIE

This text will now repeat.
age 1| Kol
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18. Select the linking tool @ from the tool palette.

You will see an arrow pointing from the lower-right corner of
Page 1 to the upper-left corner of the box on Page 2. The directio;
of this arrow indicates the direction of linking. (If the arrow does
not appear, then the box on Page 1 is not activated.)

You will now unlink the first page from the second.
19. Select the unlinking tool &» from the tool palette.

20. Move the pointer inside the Page 1 text box. Notice that
changes to a broken chain icon. Click once on the tail o
the linking arrow, making sure that the icon is totally
within the active text box.

The arrow disappears (along with the text on Page 2), and the
overflow symbol @ appears in the lower-right corner of Page 1.
The text that had previously shown on Page 2 is still available, bu
is not displayed.

You will now re-link the two pages.
21. Select the linking tool from the palette.
22, Click in the Page 1 text box to activate it.

23. Click in the Page 2 text box.

Be careful with the linking tool. Notice that the pointer changes t
a linked chain when inside the marqueed box. Using this tool, yo
may inadvertently link boxes that you did not wish linked.

In the next section, you will create a new document to explore
linking further.

24. Close the document without saving it.

Redesigning the Default Page

In this section you will redesign a document’s default page to
include three boxes. Two will be linked on the default page to
form a new automatic text chain (defined by you) and the other
you will link manually within the document.

25. Using New from the File menu, create a new document
with the same dimensions as those used in the previous
section. (Width 6", Height 4".)
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ctive box

26. In the Page Guidelines area, enter 3 for the number of
columns.

27. Click OK in the New dialog box.

This brings up the first page of your new document. Notice the
division into columns.

28. Select Show Default from the View menu.

29. With your default page showing, press the Option key
and hold it while you select the text box creation tool
from the palette. (Release the key after the selection has
been made.)

Pressing the Option key keeps the highlighted tool selected until
another tool is selected to replace it.

30. Draw three boxes side-by-side, following the column
guidelines and completely filling the column areas. See
the illustration below.

Since Snap to Guides (View menu) is a default option, your
boxes will “snap to” the column guides when brought to within
three points of a guide while being created.

_ Document2 = s
TN P .l.l.n.q.l.lnn..il.l.I.l..l.l.l.
(=]
(&}
] 3
[+ 3
N
[N f2]
(%] ]
@®| ]
l@®| ]
o la]
efault Ka] 5 (53

31. Select the editing tool ™.

32. Click inside the middle text box to activate it.
Notice the pointer change to the I-beam pointer ).
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33. Move the pointer onto the middle handle on the bottom
of the box until it turns into the resizing pointer .

34. Holding down the mouse button, resize the middle box
so its lower edge is a half-inch higher than the other
two boxes.

Document2

a0 MEEREEIEE

Default K|

35. Select the text box creation tool and draw a small text
box under the middle box. Make sure that the new box is
flush with the bottoms of the left and right boxes.

36. Insert the current box page number (3z-3).

You will now center the number on the page.

37. Under the Style menu, select Centered from the Alignmen:
sub-menu.

Remember that the default link had been to the large box in whic]
your three smaller boxes are now placed. Now you will redefine
the automatic text chain as the left and middle smaller boxes.

First, you will resize the left box in order to view the changing link
38. Activate the left box and, with the editing tool selected,

use the middle handle to pull the top of the box down
one-half inch from the top.
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39. Select the linking tool from the tool palette and click on
the intact chain icon in the upper-left corner of the
default page.

You will see the icon box marqueed.

40. Use the pointer to click in the left text box you just
resized.

You now see a pointer connecting the icon box to the now-mar-
queed new box. This box is now the one through which text will
flow when new pages are created.

41. With the linking tool still selected, click inside the large
middle box.

Notice that it is now marqueed and connected by an arrow to the
previous box.

You will link the third box manually within the document later in
this tutorial.

42. Select Hide Default from the View menu. This brings up the
newly redesigned first page with the three text boxes and the
page number box.

43. Activate the left text box by clicking inside it.

44, Select Get Text from the File menu. In the Linking Tutorial
Samples folder, Open the document called Linking Tutorial
Text 2.

The sample text will be imported and flow through the automatic
text chain you just set up.
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Notice that the text now flows only into the left box and up into
the middle box. The overflow forces the creation of new pages.

You will now see a new Page 3.
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Creating a Manually Linked Text Chain
In this section you will link two boxes on separate pages.

45. Use the scroll bar to get back to Page 1. Activate the box
on the right.

46. Select Fit in Window from the View menu.

47. Use the scroll bar to center Page 2 in your document
window, leaving the lower part of Page 1 and the upper
edge of Page 3 showing.

You will now manually link the empty right text box on Page 1 to
the empty right text box on Page 3.

[ ———— Do cument2
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48. Select the linking tool from the tool palette and click
inside the right box on Page 1.

The box will be marqueed.

49. Click on the right box on Page 3.

You will see the box on Page 3 marqueed and the arrow connect-
ing it to the box on Page 1. You have defined a link that skips
Page 2. You will now see how this affects text brought into the
first box.

Document2
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50. Select the editing tool from the tool palette.

(Notice that the arrow disappears.)
51. Select Actual Size from the View menu.

52. Scroll to the top of the document and activate the right-
hand box.

53. Select Get Text from the File menu. From the Linking
Tutorial Samples Folder, Open the document called Linking
Tutorial Sample Text 3.

After the text filled the box on Page 1, Page 2 was skipped and the
overflow went to Page 3.

Linking and unlinking boxes is simply the channeling of text
through a desired course — you can use the linking and unlinking
tools as open and closed flood gates to flow text through boxes in

any desired location within your document.

54. Close the document with or without saving your changes.
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Tutorial: Using the Find/Change
Dialog Box

Overview: This tutorial explores QuarkXPress’ Find/Change
function. In this exercise you will selectively find and alter text,
font, font size, and type styles in an excerpt from the Declaration
of Independence. The text for this exercise is on Sample Disk 1. It wa
drag-copied onto your hard disk in the Word Processing tutorial ir
Chapter 1. If you did not take the Word Processing tutorial, please
see its introductory comments for directions on dragging the sam
ple folders onto your hard disk.

Prior Knowledge Required: Familiarity with the Macintosh.
Reference Manual: We strongly recommend that you read the

Find/Change command discussion in the Edit menu before takin
this tutorial.
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Begin Find/Change Tutorial

Follow the steps below to work through a selection of
Find/Change features.

1. Double click on the XPress icon, then select Open from
the File menu. Open the folder Chap. 2 Text and then
Open Find/Change Sample Text.

The following document will appear on your screen. By the end of
this exercise, it will be somewhat more presentable.

Below is a somewhat odd-looking excerpt from
the Declaration of Independence. By the time you
have finished the Find/Change tutonal, it should
look a bit more like what you are used to

We hold these truths to be self-evident, that all men are mot
created equal, that they @are mot endowed by their creator with
certain unalienable rights, that among these are mot life, liberty,
and the pursuit of fappsness - that to secure these rights,
qovt.s are mot instituted among men deriving their just powers
from the consent of (i@ E@¥Erem®E, that whenever any form of
qovt. becomes destructive of these ends, it 73 the right of the
people to alter or to abolish it, and to institute new govt, laying its
foundation on such principles, and organizing its powers on such
form, as to them shall seem most likely to effect their safety and

2. Use the mouse to activate the box containing the text.

Activating the box for the first time automatically places the text
insertion bar at the top of the document.

It is essential that the text insertion point be at the beginning of
the range of text you wish to search. Searches take place from

the text insertion point to the end of the text chain. To better
understand what you are doing, please read the first paragraph of
the sample text.

On a Macintosh SE-size monitor, you will have to scroll right to
center the text in the document window.
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3. Select Find/Change from the Edit menu (3-F). The follow-
ing dialog box will appear.

E======—==—— Find/Change

Find what: Change to:

Ir'[ll'ext | ﬁ'eu! I

O Whole Word @ Partial Word [X Ignore Case [X] Ignore Attributes

[ Find Nent ) (cnange, then Find ) ((Change ) (Change AN )

Changing a Word

For the first exercise, you will change the word “govt.” to
“government.”

4. In the Find what field, type “govt.” (no quotation marks).

When using the Find/Change feature for text, “govt.” is referred
to as the “search string.”

5. Press Tab to move to the Change to field. Type “govern-
ment” in that field. Notice that the Find Next button is nov
active.

Notice also the buttons and check boxes just below the text fields.
Leaving Partial Word and Ignore Case selected means that
“govt.” will be found even if it is upper case and embedded in
another word, as in the non-existent word “Govtgrant.”

Ignore Attributes will be discussed in the next section.
You may use any of the change buttons to selectively alter text.

1) Change, then Find replaces the search string (“govt.” in this
case) and searches for its next instance.

2) Change replaces the search string.

3) Change All replaces all instances without stopping for verifica:
tion at each one; it gives you a total of the number of instances
changed when the search is completed.

6. Click Find Next. You will see the first instance of the search
string highlighted in the document (“govt.s are not...”).
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7. Click Change, Then Find. The search string is replaced
and the next instance is found. Since there are only
four instances of “govt.,” repeat this method until
the Macintosh beeps to tell you there are no more
occurrences.

(Note that whenever the Find/Change dialog box is frontmost on
the screen, the blinking text insertion bar does not show in your
document. Always be sure that you have placed the text insertion
bar at the beginning of the block of text you want to search before
you open the Find/Change dialog box. In most cases this is at the
top of the document.)

Changing Font and Size

In the next section of this exercise you will change font and size.

8. Click on the document to bring it forward and activate it.
Click 3z-Option-+ to put the text insertion bar back at the
top of the document (to the left of the word “Below”).

9. Use the keyboard equivalent s¢-F to reopen the
Find/Change dialog box.

10. Click on the Ignore Attributes check box to uncheck it. An
expanded version of the previous dialog box is displayed.

fO==———————==—=find/(hange S "=—=—==—|

Find what: Change to:

) Tent - Text

[government 1
~X Font——— - [X] Size -~ Font—— - [X Size

[Times | [ﬁtl pt ||| [Times ] [| 14 pt |
~X styte & style

(X Plain [J Underline X Plain [ Underline

[ Bold [ word u.l. O Bold O werd u.l.

[ 1talic [ small Caps [ 1talic [ small Caps

[] outline IRl Caps [J Outline ] Al Caps

[J] shadow [ Superscript [ Shadow [ Superscript

[J Strike Thru  [] Subscript [ strike Thru [ Subscript

O Whole Word @ Partial Word [ Ignore Case [] Ignore Attributes

|m (thange. then Find_) ((Change ) ((Chooge au )
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Note that the text search and replacement strings from the previ-
ous section are still in the text fields. You will not find or change
text in this section.

11. Click on the check boxes for the text field in the Find
what column and the Change to column to remove them
from consideration in the search. (The outlines of the box
and any text in the fields are grayed.)

El=F=——==r——— Find/lhange =——————"V{|

Find what: Change to:
~[] Text -] Tent
§qlmt. ég(mermnem
-~ Font—— ~[X] Size - Font—— ~[X] Size
[Times J|[[14 pt || | [Times ] [|I4 pt |
~BJ Style ~[X Style
X Plain [J Underline X Plain [J Underline
[JBold (] word u.l. [JBold [J word wu.l.
O 1talic [ small Caps [ 1talic [ Small Caps
[ Outline [J Al Caps [] outline [J ANl Caps
[ Shadow [ Superscript [J Shadow [ Superscript
[J Strike Thru [ Subscript [ strike Thru  [] Subscript
O Whole Word @ Partial Word (X Ignore Case []Ignore Attributes
(_change, then Find ] ( Change ) ( Change Al )

The Font field in the Find what column reflects the first font used
in your document (the font immediately to the right of the insertior
bar). All fonts currently contained in your document are listed in
this font pop-up menu.

12. In the Find what column, click on the current font setting
(Times) and select Monaco from the pop-up menu.

13. Leave the Size setting at 14. Click on the Style check box
to deactivate it.

These settings tell the program to look for all 14-point Monaco,
regardless of type style.

14. Select Geneva from the Change to font pop-up menu.
(You may have to scroll through your font selections.)

This font menu gives a listing of all available fonts on your system.
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15. The Change to Size shows a size of 14. Change this to 12.
Again, deactivate the Style check box. Your settings should

look like this:
[E0=====—=—=—=——===== rind/Change =
Find what: Change to:
~[] Text ~[] Texnt
§q|)ul. §g(ll'(u‘nln(~.m """""
~Bd Font X size -0 Font—— ~[X Size
[Monaco | [[ 14 pt || |[Geneva ] [l 12 pt |
~[] Style ~[] Style
X plain O undertine X Plain O vadertine
8ot O Word u.l Onaid O ward vl
O ttadic O smali Caps O natic O Smal Caps
[ buttiae &t Caps O tutline [ sn Caps
O shadou O superscript O shadow [ Superscript
Ostrike trw [J Subseript O strike Thry ] Subscript
O Whole Word @ Partial Word [X Ignore Case []Ignore Attributes
‘ Find Next I[ Change, then Find ) ( Change ] ( Chenge All )

The settings in the Change to column tell the program to replace
all 14-point Monaco with 12-point Geneva. To abbreviate the dia-
log box so that you can see your changes, click on the zoom box in
the upper-right corner of the dialog box.

You will notice that the items found (14-point Monaco) are bold-
faced and italicized to enable you to see them changed in the text.

16. Click on the Find Next button. Since there are only three
instances to be changed, use Change, then Find to finish
the substitutions. The Macintosh beeps to alert you when
there are no more occurrences of the search criterion.

When your search is completed, close the dialog box and return

the cursor to the top of your document ($-Option-t) and then
press $8-F to get back to the Find/Change dialog box.

Changing Type Styles

You will now search for and change specific text styles.
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17. Use the zoom box to return to the expanded dialog box
Click on the Font and Size check boxes in both the Find
what and the Change to columns to deselect them; maki
sure the text fields are still deselected. (This tells the pro
gram not to consider text, font, or size in its search.)

18. Under the Find what column, activate the Style area by
clicking on the Style check box (the Style options will be
available); click on Outline twice to check it.

The three states of a style check box are grayed, checked, and blan
These conditions will repeat cyclically as you click on the box.

19. Click on Strike Thru once to gray its check box.

When a Style attribute in the Find what section is checked, the
attribute must be present for an item to be found. If an attribute is
grayed, it does not matter if the attribute is present in the item to t
found. If an attribute is blank, the attribute must not be present for
the item to be found. For example, Italic is unchecked in the Fin
what column, therefore, nothing in italics will be found.

Notice that Plain affects all other Style entries. Checking Plain
unchecks all other check boxes. Graying any or all boxes grays
Plain. Checking any other box unchecks or ungrays Plain.

In our search, all items to be found must be Outline, but can alsc
be Qutline and Strike Thru.

You will now replace all outlined items with outlined small caps
outlined items with strike-throughs will also be replaced.

20. In the Change to side of the dialog box click to activate
Style, click on Small Caps twice to check its box. Click on
Outline once to gray it. Leave StrikeThru unchecked (blank

Because Outline is checked in the Find what column and grayec
in the Change to column, it will not be changed in the search.
However, since Strike Thru is grayed in Find What and is left
blank in the Change to column, that attribute will be removed
from any text that is changed.

All Outline characters, including Outline and Strike Thru, will
be changed to Outline with Small Caps.
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21. Use the zoom box to abbreviate the dialog box.

22. Click Find Next.

The first instance of your search string will be highlighted in
the text.

23. Click Change to see the effect of your substitution. Press
Find Next again. Now click Change, then Find until all
three instances of the search styles have been changed.

Changing Text, Font, Size, and Style

In this section, you will search for specified text “are not” and
change this text, its font, its size, and its type style.

24. Close the Find/Change dialog box and scroll to the top
of the document. In the first paragraph of your docu-
ment, find and highlight the first occurrence of the words
“are not.” Be careful not to highlight any spaces on
either side of the words, as these spaces may have
different attributes.

Highlighting the word(s) you desire to change brings that text’s
font, size, and type style into both the Find what and the Change
to columns of the Find/Change dialog box.

25. Click s¢-F to reopen the Find/Change dialog box. Click on
the zoom box to expand to the full dialog box.

You will now search for the words “are not” and replace them
with the word “are” in the appropriate size and type style.
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26. Click on the Find what text field check box to activate it
and type in the words “are not”.

27. Activate the Change to text field. Enter the word “are”.

28. Click on the Change to column Font name and select
Geneva from the pop-up menu.

29. Use the mouse to highlight the Size field under Change tc
Enter a value of 12.

30. In the Style section under Change to, uncheck Bold and
double click on ltalic to check it.

This will replace the bold-faced,14-point Chicago “are not” with
the italic 12-point Geneva “are.”

f0====—=—=———— Find/Change =
Find what: Change to:
- Text ~[X Text
[are not I [are |
-~ Font———— [X Size ~&J Font——— X Size
{Chicago | [l 14 pt || | [Geneva | [l 12 pt |
- Style ~[X] style
[ Pain [J Underiine [ Plain [J Underline
(X Bold CJword u.l. [ Bold [ word u.l.
[ 1talic [] Small Caps X Italic [J Small Caps
(] Dutline AN Caps [ outline Al Caps
[] Shadow [] Superscript [J Shadow [J Superscript
[]Strike Thru  [] Subscript [ Strike Thru  [J Subscript
O Whole Word @ Partial Word [ Ignore Case [ Ignore Attributes
l Find Next '[ Change, then Find ) (_Change ] ( Change Al )

31. Abbreviate the dialog box by clicking on the zoom box.
The first instance of the search string will be highlighted
Click Change. Notice the effect of your substitution.
32. Click Find Next to highlight the next instance.
33. Select Change All. Note the count of changed items.
34. Click OK in the count dialog box.
Changing All Text

You will now use Find/Change to change all of the text, fonts,
sizes, and styles to plain 12-point Geneva.
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35. Close the Find/Change dialog box and move the cursor to
the top of the document (32-Option-t). Press -F to get
back to Find/Change.

36. Expand the dialog box using the zoom box.

37. In the Find what column, uncheck Text, Font, and Size.
Under the Style section, gray Bold, Italic, Outline, Strike
Thru, and Small Caps.

Note that Plain is grayed.

All occurrences of these type styles will be searched for regardless
of font or size. Note that graying Small Caps also grays All Caps.
This is because the two are mutually exclusive — text cannot be
both Small Caps and All Caps.

38. In the Change to column, uncheck the text field, change the
font to Geneva, and the size to 12. Leave Style set on Plain.

This will change all bold, italic, outline, strike thru, or small cap
characters, of any size and font, to 12-point plain Geneva. Had
other attributes been present in the text, (e.g. Shadow, Underline,
Word Underline, Superscript, or Subscript) they would not have
been found in the search.

39. Abbreviate the box and click Find Next. The entire text
will be highlighted.
All styles have been found, which means all text is selected.

40. Click Change and the entire document will be changed to
12-point plain Geneva.

41. This concludes using the Find/Change dialog box. Close
the Find/Change dialog box and click on the document to
clear the highlighting.

42. Read the important note below before closing the document.

Note: If someone else needs to work through this exercise, do not
save the many changes you have made during the tutorial. This
will give them a clean slate on which to work. Now you may close
the document, saving or not as you wish.
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Tutorial: Introductory Typesetting

Overview: This tutorial is an introduction to some of the typeset-
ting features of QuarkXPress: leading, tracking, kerning, and hori-
zontal scaling. You will be modifying a block of text (the first para
graph of the Declaration of Independence) found in the folder

Chap. 2 Text. If this folder is not on your hard disk, see the intro-
ductory comments in the Word Processing tutorial for instructions.

Prior Knowledge Required: It is assumed that you are familiar
with your Macintosh. It is also assumed that the program is
installed on your Macintosh, that you have drag-copied the sam-
ple documents from Sample Disk 1 onto your hard drive, and that
you are in the Finder, ready to begin this tutorial.

Reference Manual: You will find it helpful to read the discussion
in the reference manual related to the following commands.

Style menu Horizontal Scale
Kern/Track
Alignment
Leading
Formats

View menu: Show Invisibles

You may also wish to read the section entitled Initial Caps in
Chapter 4.
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Sample: Below is the excerpt from the Declaration of Independence
as it will look after you have finished the tutorial.

Declaration of Independence

hen in the course of human events, it becomes nec-

essary for one people to dissolve the political

bands which have connected them with another,
and to assume among the powers of the earth, the separate
and equal station to which the laws of nature and of
nature’s God entitle them, a decent respect to the opinions
of mankind requires that they should declare the causes
which impel them to the separation.

Begin Typesetting

In the Finder, open the QuarkXPress folder on your hard disk and
click on the XPress application. This opens the program.

Opening the Sample Text

1. From the File menu, select Open.

2. Open the document Typesetting Sample Text.

When working with text, it is easier to see what you are doing and
the changes you are making if invisible characters (such as spaces
and paragraph returns) are visible.

3. From the View menu, select Show Invisibles.
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The following document will show in your document window.
By the end of this tutorial it will look like the finished sample on
the previous page. Notice the invisible characters that appear in
your document.

= 1;].1.‘].“].1‘2[.1Al.l.al.l.IAl.dl.l.I.|.5'-|.l.l.q—.
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] Whe n-in-the .course of human events, it bec omes necessary.1
b one people to dissplve-!hepolitical—bmds which have-

4. If you are working on a Macintosh SE-size screen, move
the scroll box to the right to center the document.

Tracking the Headline

Tracking removes or inserts small amounts of white space in a
range of highlighted text. In this section you will use the tracking
command to reduce the white space between the letters of the
words “Declaration of Independence” in order to fit them on one
line. You will then use a new line character to justify the line.

5. Use the mouse to highlight the headline. (It does not
matter if you include the paragraph return.)

6. From the Style menu, select Track.
The following dialog box is displayed.

Track amount:

Cancel
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The normal tracking value is zero. Positive tracking values
increase white space and negative entries decrease white space.

7. Enter a value of “-2" in the Track amount field.

8. Click OK.

Notice that the headline characters are closer together, but the
headline is still on two lines. You will now use the keyboard com-
mands for Tracking to fit the headline on one line.

9. With the headline still highlighted, hold down the
Command key 3z, the Option key, and the Shift key and
then press the { key once (this keyboard command is
written 3¢-Option-Shift-{).

Each time this combination is pressed, QuarkXPress subtracts .005
em of white space from the right of each highlighted character. (If
you do not press the Option key, QuarkXPress will track in .05 em
space for faster character placement.) You can press the keyboard
command for tracking until the text is fitted the way you want it.

You can check the amount of tracking you have done through the
Track command in the Style menu.

10. Select Track from the Style menu.

Notice that the tracking value is -3, resulting from the -2 you
entered in the dialog box plus the -1 you entered through the key-
board equivalent. This means that you have removed 3/200 em
from between each of the character pairs.

11. Click OK.

12. Press the key combination 32-Option-Shift-{ twice. (Hold
down the 3, Option, and Shift keys and press { twice.)

This will bring the tracking down to -5 — not quite enough to
reduce the headline to one line. To finish the job, you will hori-
zontally scale the headline.

13. With the headline highlighted, select Horiz Scale from the
Style menu.
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The following dialog box appears.

Horiz scale:

14. Enter a value of “90”. Click OK.

This reduces the width of all highlighted characters by 10%. The
headline will now fit on one line.

Justifying the Headline

Although the heading is now on one line, it is still not justified.
Notice the small space between the end of the heading and the
right margin.

15. With the headline highlighted, go to the Style menu and
select Justified from the Alignment command sub-menu.

There will be no noticeable change in the heading. You will now
delete the Return character at the end of the line and replace it
with a new line character.

16. Move the blinking insertion bar into the line immediately
below the heading.

17. Press delete.
The body text moves up.

18. Holding the Shift key, press Return.

This combination (Shift-Return) is the command for the new line
character. The heading is now justified.
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Kerning Headline Characters

Kerning in QuarkXPress is a feature that shows best on high-reso-
lution printers. Kerning is done largely for artistic reasons, as
opposed to tracking, which is largely done to fit text into a specific
area. In this next section, you will kern two letters closer together.

19. Use the mouse to place the text insertion bar between
the first and second letters of the word “Declaration.”

20. Select Kern from the Style menu.

Notice that when the text insertion bar is between characters the
Track entry in the Style menu changes to Kern, and that it is
currently checked.

Kern amount:

BT
(oK ]
3 -

The Kern dialog box shows that the letters d and ¢ have been previ-
ously kerned to 10/200ths of an em-space. Since many characters
look better when kerned closer than the default setting of zero, you
will change this excessive spacing first to the default and then to a
negative number.

QuarkXPress kerns to 1/200 (.005) of an em space. For example,
an entry of -1 in the Kern amount dialog box will remove .005 em
space from between the character pair.

21. Enter “0” in the Kern amount dialog box. Click OK.

By resetting the kerning value to the default, you removed the
excess spacing. To kern the characters closer you will now use the
same keyboard equivalent as that used to track characters.

22. Press the command sequence -Option-Shift-{ five times.
(Hold down the 3, Option, and Shift keys, and press {
five times.)

The heading blinks as the excess space is removed. As with tracking,
QuarkXPress allows you to kern to .05 em for faster white space
control by not pressing the Option key as part of the combination.
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Establishing Leading

Leading refers to the amount of white space between lines. The
leading for the sample paragraph is set on “auto,” meaning that th
leading consists of the point size of the given font plus 20%.

23. Highlight the body text.

You will now change the leading to an absolute value based on
the current font size, meaning that you will determine the font
size of the text in the paragraph and set the leading just a couple
of points greater.

24, Press 3-Shift-\ on your keyboard. This is the keyboard
command for the sub-menu choice Other (Style > Size).
The following dialog box is displayed. Notice that the
font size is 17.

Font size: 1?7 pt

25. Click Cancel.

26. Select Leading from the Style menu.
The following dialog box appears.

Leading:

7 R

27. In the field containing the word “auto,” enter “20”.
Click OK.

This will set the leading for each line in the paragraph at 20
points, regardless of the presence of different font sizes. The white
bars you see between the lines of highlighted text indicate the
new leading values.
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28. Making sure the text is highlighted, justify the text by
selecting Justified (Style - Alignment).

The text is now flush up against both the left and right margins.

29. Deselect the text by clicking anywhere in the box.

Creating a Drop Cap

To finish the tutorial and give the sample text the look we want,
you will create a drop cap.

30. Delete the first letter of the first word in the body of the
text. (The Win When.)

31. Draw a small text box roughly three lines deep by 1"
wide in the upper left of the paragraph.
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32. From the Font sub-menu in the Style menu, select Times.
33. Select the editing tool and type a W in the small box.

34. Select the W and use the keyboard command 3s-Option-
Shift-> to increase the drop cap’s size in one-point incre-
ments until it fills the box.

35. Continue to increase the drop cap’s point size until you
get an overflow symbol. When this happens, reduce the
font size with 3£-Option-Shift-< until the W reappears.

You will now use the keyboard command for horizontally scaling
a character in 5% increments. Reducing the width of the characte
will allow you to increase the font size so that it completely fills
the small text box and lines up correctly with the first three lines
of text.

The drop cap should align with the tallest ascender of the first lin
and the baseline of the third line.

36. Highlight the W in the small text box.

37. Hold down the 3¢ key and press the [ key twice.

This reduces the horizontal scale 10% and shows how to scale the
character horizontally to fit it to the box. Changing the font size
modifies the vertical fit.

38. Reduce and enlarge horizontal scaling and font size unt
the character is properly aligned.
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39. To get a better idea of how this final piece looks without
printing it, select Hide Guides from the View menu and
deselect the drop cap box.

L'A‘Illlllllzllllllllall‘llIll ;1.1.141.1“.1.6[.[.].

Declaration of Independence

hen in the course of human events, it becomes

necessary for one people to dissolve the political bands

which have connected them with another, and to
assurme among the powers of the earth, the separate and equal
station to which the laws of nature and of nature's God entitle
them, a decent respect to the opinions of mankind requires that
they should declare the causes which impel them to the
separation.
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This concludes the Introductory Typesetting tutorial.
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Overview: In this tutorial you will design a mock-up for a maga-
zine cover. You will import and modify a color TIFF picture, cre-
ate a color which you will apply to display text and a rule, and
typeset the cover text.

As in all tutorials, please read the entire numbered step before
performing any of the actions.

Prior Knowledge Required: You should be familiar with your
Macintosh and the mouse, be able to type, and have read the
introduction to the QuarkXPress Manual. Several of the concepts
dealt with in the following exercises were introduced in previous
tutorials. You should work through the Working with Boxes and
Lines tutorial in Chapter 1 if you have not yet done so.

The tutorial assumes that you are working with a color monitor.
The sample pictures for this tutorial were drag-copied from
Sample Disk 2 at the same time as those for the Working With Boxes
and Lines tutorial. If you did not take that tutorial, see its introduc
tory comments for instructions on dragging the samples onto
your hard disk.

Reference Manual: We strongly recommend that you read the fol
lowing sections for maximum comprehension of the procedures
discussed in this tutorial:

Introduction: Boxes in The Tool Palette

Style menu: Style Menu for Pictures
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Sample: The final product of this tutorial is the magazine cover
shown below.
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From the Finder, open your hard disk and the QuarkXPress
folder and double-click on the XPress program icon to get into
the program.

Creating the Document

1.

2.

Select New from the File menu.

In the New dialog box, click OK.

This brings up the first page of the new document. You will now
delete the large page text box and replace it with a picture box of
the same size.

3.

4.

Activate the large text box by clicking on it.
Press :z-K to delete the box.

Select the rectangle picture box creation tool x from
the palette.

Bring the cursor into the document and onto the upper-
left intersection of the guidelines.

Holding down the mouse button, drag diagonally down
and to the right to completely fill the 7.5" x 10" box.

Scroll back to the top of the page.

Importing the Picture

9.

Insert Sample Disk 2 into your drive.

10. Select Get Picture from the File menu.

11. In the Get Picture Directory dialog box, open the folder

Chap. 2 Picts.
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12. Open the document called Color Sample TIFF.

There will be a short pause while the picture is brought in. The
large X in the picture box is replaced by the imported picture.

J Document |

S al o »

| Page | |6

Modifying the Picture

You will now use Modify (Item menu) to enlarge the picture to fit
the box.

13. From the Iltem menu, select Modify.
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The following dialog box is displayed.

Document|

m Picture Box Specifications
| Background
Origin Across: ISR 9
| Origin Down:  0.5° Caloes
s S| Width: 7.5 Blue
[ . Cyan
Height: 10
! s e Green
=, Scale Aicross:  100% | |Magenta
[ = s Scale Down: 100% shade: [0 E Y
i = Text Qutset: 0"
| )t F
| Transparent ||
1 [] Suppress printout @
- -3 )
| Page 1

14. Press the Tab key four times to move down to the Scale
Across field. (It will then be highlighted.)

15. Enter a value of “250".

16. Tab to the next field (Scale Down) and enter a value
of “250".

These values will enlarge the picture 250% without distorting it.
17. Click OK.
You will now use the picture moving tool { to move the picture up

18. Move the pointer inside the picture box. (The pointer
changes to M.)
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19. Holding the mouse button, drag up slowly. Stop when
the edge of the welder’s shoulder is roughly a quarter-
inch below the top of the picture box. (See the sample
illustration at the beginning of the tutorial.)

The picture may shift to the left and right while you move it.
When done, check to make sure the picture extends to the left and
right sides of the picture box.

Creating Text Boxes

You will now draw the three text boxes that will contain the title,
date, and contents information. In order for the text, which you
will input later, to line up correctly, it is essential that these boxes
be exactly the correct size.

To help you size your boxes, you will first move the zero-points
on the two rulers along the top and left edges of the document
window. This is called resetting the ruler origin. The ruler origin is
the small box at the intersection of the two rulers.

20. Move the pointer into the ruler origin.

21. Hold down the mouse button and drag out the guidelines
until the intersection of the two is on top of the upper-left
corner of the text box (the guidelines will “snap to” the
box outline). The horizontal and vertical guidelines will
line up exactly with the top and left edges of the text box.

Release the mouse button.

The rulers are now reset so that the zero points align with the
edge of the text box rather than at the edge of the page.

22. Select the text box creation tool @.
23. Starting on the upper-left handle of the picture box, draw

a text box two-and-a-half inches high extending across
the picture.
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Your box should look like this when finished.

Document!

You will now draw a small box inside the one you just created to
hold the volume number and date.

24. Select the text box creation tool @ and, anywhere in the
box, drag out a box one-and-a-quarter inch high and two
and-a-half inches long.

25. Select the mover tool < from the palette, place the point:

er inside the active smaller box, and drag it to the lower-
right corner of its parent.

You will now draw a box flush up against the left and bottom
margins of the picture to contain the “in this issue” information.

26. Scroll to the bottom of the page.
27. Select the text box creation tool @.

28. Starting in the lower-left corner, drag out a text box 4"
wide and 3" high.
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29. Scroll to the top of the document and select 50% from
the View menu.

Your document should now look like this.

i — = Document | :
|
2 28 4 1
H

Inserting Text
You will now type in the text for the three boxes.

30. Choose Actual Size from the View menu and select the
1™ tool.

31. Activate the large text box that runs across the top of the
page and type in the words “Computerized Photography”.

32. Use the mouse to highlight the text.

33. Hold down the x key and the Shift key and press the >
key six times.
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This increases the font size through a pre-determined range. The
final title will be 60 pt. and rest on two lines.

34. Activate the smaller box below and to the right of
“Photography” by clicking on it.

35. Enter the words “Volume 3, Number 1 [Return] July 1988”
in the smaller box.

36. Highlight the text.

37. Go to the Style menu and, from the Alignment sub-menu,
select Right.

The text is now aligned along the right margin.

38. Press 3-Shift-> once to increase the font size one setting
in the preset range.

This increases the font size from 12 to 14 points.

You will now input and format the text for the text box at the bot-
tom of the page.

39. Scroll down to the bottom of the page and activate the
small text box.

40. Type in the following lines:

“In This Issue... [Return]

Color Manipulation Using QuarkXPress [Return]

Computers Move into the Darkroom [Return]

Digital Image Retouching: Is What You See What They Got?”

Formatting the Contents Information

You will now modify the font size and paragraph formats for this
text box.

41. Highlight the first line.

42. Press 3-Shift-> twice.

This increases the font size to 18 points.

43. Italicize the first line by pressing s¢-Shift-.
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44. Deselect the first line and highlight the rest of the text.

45. From the Style menu, select Formats.
The following dialog box is shown.

=== Paragraph Formats ===

Left Indent: Leading: auto |

First Line: 0" Space Before: |0"
Right Indent: (0" Space After: (0"

ok ] (cancer)  (_Apply

46. Press the Tab key four times to get to the field labeled
Space Before. Enter a value of “.15” in this field. Click OK.

This opens up .15 inches between the paragraphs.

47. With the text still highlighted, press -Shift-> to increase
the font size to 14 pt.

48. From the Edit menu, select Select All.

All the text in the box is highlighted. You will now bold the text
using a keyboard command.

49. Press 3£-Shift-B.

The text is now in bold face.

Custom-designing a Color

You will now create a custom-designed color that will be used for
all text on the page.

50. From the Edit menu, select Colors.
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The following dialog box is displayed. You will notice some

distortion of the colors in your document. This is a result of the

colors being displayed in the dialog box and the limited color

capacity of the screen. The distortion will not be present after the

dialog box is closed.

& T pocumentt

Colors tor Document|
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White { ([ deles

1his Is3508
Color Manipulation Using QuarkxPress
Computers Moye into the Darkroom .
Digital Image Retouching: Is Whal You See
‘What They Got?

| Page |

51. Click once on the New button.
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The following dialog box is displayed.

. . Edit Color
ey Name:
P Cover Color

Model

QOHSBE @®@R6EB O CMYK
(O PANTONE®

Process ===

: '.'I:, -Separation— New:
Rl | @orn
|/t [Oon oid:

Colol|
Corn|

o) (ox ) (Cancer)

52. In the Name field in the upper-left corner of the dialog
box, enter Cover Color (as seen above).

53. In the Model area, click on the CMYK button to change
the default model from RGB (red, green, blue) to CMYK
(cyan, magenta, yellow, black).

(This is the model used by professional printers.)

54. Move the pointer & into the color wheel.

Notice that it changes to a crosshair pointer.

55. Click once on the middle shade of yellow.

You will see a dot in the place that you clicked and a representa-
tion of the selected color in the New field in the middle of the dia-
log box. The selected color’s numeric components are given in
percentages beneath the color wheel.

PRACTICE WITH QUARKXPRESS 2-49



2-50

You will now change the numeric settings to obtain the desired
shade of yellow for the magazine cover text.

56. Tab once to move the cursor from the Name field into th
Cyan field. (The Cyan field will be highlighted.) Enter a
value of “0” (if it is not already).

57. Press Tab to get down to the Magenta field. Enter a valu
of “11.4” in the Magenta field.

58. Tab to the Yellow field. Enter a value of 100 in the Yellow
field. (If the the value of Black is not set to 0, Tab to it an
reset it.)

Notice that the New field changes color to reflect the changing
values.

Edit Color

Name:
[t over Color 1

1o

Model

OHSB  ORBB @ (MYK

(O PANTONE®

Process ‘ ‘” )
~Separation— New: ol o

@orr =

Oon 0 Cyan: Lﬁ ED':[E]

Magenta: ar \ &) =)

l.m:‘ Yellow: E (] I <)

Black: D m

59. Click OK.

You are returned to the main Colors dialog box.

60. Click Save to save the color.
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You are returned to the document. You have now added Cover
Color to this document’s color palette. (You can see the color in the
Style menu’s Color sub-menu, if you care to look.)

Modifying Cover Text

You will now modify the positioning of the cover text, its color,
and the transparency of the three text boxes.

61. Scroll to the top of the document.
62. Activate the text box containing the title.

You will now establish a Text Inset value that will move the text
away from the edge of the box. You will also set the box status to
Transparent, so that the underlying picture will show through.
You will then do the same for the other two boxes.

63. From the Item menu, select Modify.

64. Press Tab six times to highlight the Text Inset field. Enter a
value of “10”".

65. Click on the Transparent check box.

This will render the text box background transparent, allowing
the text to be superimposed directly on the picture. This will be

displayed later.

66. Click OK.

67. Highlight the text, if it is not already.
68. Press 3-Shift-B to bold the text.

69. From the Style menu, select Cover Color from the Color
sub-menu.

The title is now colorized with the custom color you designed in
the previous section.

70. Click on the small “volume” box to activate it. (The title
box becomes transparent.)

71. Highlight the text.
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72. From the Style menu, select Cover Color from the Color
sub-menu.

The volume information is now colorized.
73. From the Item menu, select Modify.

74. Press Tab six times to highlight the Text Inset field. Enter a
value of “10".

75. Click on the Transparent check box. Click OK.

The small box is now transparent.

76. Click in the white area outside the picture to eliminate
the handles of the now-transparent box.

You will now repeat these steps for the box at the bottom of
the document.

77. Scroll to the bottom of the page and activate the “In this
issue” text box.

78. From the Item menu, Select Modify.

79. Enter a Text Inset value of “10” and click on Transparent.
Click OK.

80. Highlight the text (if it isn’t already highlighted).

81. From the Style menu, select Cover Color from the Color
sub-menu.

The contents box text is now colorized.

82. Click in the margin outside the picture.

The box is now transparent.

Creating the Title Rule

You will now draw and color a rule which will align with the tex
at the top of the page.

83. Scroll to the top of the document.
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84. Select the orthogonal line creation tool + from the
tool palette.

85. Draw a line a quarter-inch above the lower edge of the
title text box extending from the left edge of the title to
the right edge of the volume information.

86. From the Style menu, select the double-bar style shown
below.

87. In the Style menu, select a width of 8 points from the
Width sub-menu.

88. Again from the Style menu, select Cover Color from the
Color sub-menu.

89. To get an idea of how the final product would look if
printed, deselect the line and select Hide Guides from the
View menu.

90. From the View menu, select 50%.

The cover should now look like the final product shown at the
beginning of this tutorial.

Modifying the TIFF Picture

You will now use the Other Contrast command in the Style menu
to change the levels of magenta and yellow in the TIFF picture.

91. With the editing tool ™ selected, click on the picture,
but not in any of the text boxes.

Clicking on the picture sends all text behind to allow a better view
of the changes you are going to make.

92. From the Style menu, select Other Contrast.
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The following dialog box is displayed.

Document |

Picture Conltrast Specifications

1 rColor —l Model
X @ HSB

] Hue

P [-) Saturation ) R6B
- F b 7
=3 [ Bnightness | | O MY
= 3 O tMYK
[ Negative

, L0k (cancer ] (Appiy )

Page | - ) —

(For a complete discussion of this dialog box and an explanation
on how to read a contrast curve graph, see the Other Contrast
section of the Style menu in the reference manual.)

93. In the Model area, click on the CMY button.

Notice that the Color check boxes change from Hue, Saturation,
and Brightness to Cyan, Magenta, and Yellow — the color compo-
nents of the selected model.

Modifying The Cyan Contrast Curve

Upon looking at this picture you may decide, for the sake of this
exercise, that there’s a little too much red in it. The color wheel
shown below indicates that you should add red’s complimentary
color to reduce the amount of red displayed. Red’s complimentary
color is cyan (the product of equal amounts of blue and green).
Note that when all three elements of the model are selected, the
three curves are on top of one another.
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94. Use the pointer to deselect the Magenta and Yellow check
boxes. (Cyan should remain selected. This allows you to
work with one color element of the model at a time.)

Deselecting magenta and yellow brings the cyan curve forward.

Picture Contrast Specificalions

L3 Color ‘—Modd
- [ Cyan O Hse
s [ ™Magenta O R6B
a2 [] Yeliow ® ™My
3 O tMYK
[ Negative

L% __J (Cancer ) [_appiy |

_Page 1 I ) 1

95. Drag the Picture Contrast Specifications dialog box to the
upper-right corner of your document window for a better
view of your changes.

96. Hold down the Option key and click on the Apply button
in the dialog box. This keeps the Apply button active, so
that any changes you make in the contrast curve will
show up in the picture immediately.

97. Move the pointer into the contrast curve. (Notice that it
changes into the hand tool {m.)

You will use the Shift key to constrain the movement of the
curve vertically.
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98. With the hand positioned anywhere in the graph, hold
the Shift key, hold down the mouse button and drag the
cyan curve up slightly. Release the mouse button and
Shift key.

I 7 Picture Contrast Specifications
G o B W Color —
. P . [X] Cyan

[J™Magenta
] Yellow

[INegative

| Page 1

Notice that as soon as you released the mouse button the changes
in the cyan content were visible in the picture.

Modify the curve however you like. You can always return to the
normal color values by selecting the normal contrast tool 4, which
looks like the original 45-degree curve, from the dialog box palette

Modifying The Yellow Contrast Curve

99. Deselect Cyan and click on Yellow in the Color area.

Deselecting cyan and magenta brings the yellow curve forward.
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100. Use the ¢ tool to move the curve both up and down
slightly.

(Magenta may be manipulated in the same way by deselecting the
other two components.)

Reverting to Normal

101. With only Yellow checked in the Color area, select the
normal contrast tool from the dialog box tool palette.

The curve is back to its normal 45-degree slope for all yellow values.
102. Check Cyan in the Color area and deselect Yellow.

103. Select the normal contrast tool from the dialog box palette.

The picture now contains the same amounts of the various colors
that it did when you first imported it.

104. Click OK to close the dialog box.

105. Click outside the picture to bring the text forward to
once again view the final product.

106. Close the document, saving or not as you wish.

Using the Contrast Curve to Modify a Color Bitmap Image

Included in the folder Chap. 2 Picts on Sample Disk 2 is a color
bitmap drawing of a kachina doll. To further explore the Other
Contrast dialog box functions, create a document and use Get
Picture to import this picture, then modify the drawing using the
HSB color model.

Modifying Another Tiff Picture

In the folder Sample TIFF on Sample Disk 1 is another color TIFF
picture of several color pencils. This picture contains all of the
points of the color wheel (Red, Green, Blue, Cyan, Magenta, and
Yellow). Modifying it using the Other Contrast dialog box will be
a useful exercise.
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Introduction

Tutorial:

The Frame Editor program is included with the QuarkXPress
package. It allows you to create bitmap frames for use on text boxes
and picture boxes. A frame is any plain or fancy border around a
box. A frame might be used around an advertisement, picture, or
special article. QuarkXPress provides two types of frames:
mathematically-defined and bitmap.

QuarkXPress provides several pre-designed mathematically-defined
frames that can be resized, but not edited. Mathematically-defined
frames consist of continuous lines of various widths that are based
on equations. They can be used on boxes of any shape. An
advantage of these frames is that they print faster than bitmap
frames. Mathematically-defined frames are accessible through the
Frame command (Item menu).

The frames editable with Frame Editor are bitmap frames. These
frames are represented by pixels (dots on the screen) that are “on”
or “off.” They are constructed by entering or deleting dots. These
frames can be used only on rectangular boxes.

New Frame Design

The QuarkXPress Frame Editor enables you to create and modify
bitmap frames. Once you have created or modified a frame, it is
automatically included with the frames that are available in
QuarkXPress.

To give you a quick overview of Frame Editor, you will first design
a simple frame. Then you will make some changes to the frame.

Getting Started

1. Turn on your Macintosh and open the XPress folder. Find
the Frame Editor program.

2. Open the Frame Editor icon.

&

Frarro= Editor
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Note: The Frame Editor must be on the same disk as QuarkXPress.
If QuarkXPress is in a folder then the Frame Editor must be in the
same folder.

Style Selection

Style Selection

You should now have the Style Selection window on your screen.
Look briefly at the frame styles that are available in the Style
Selection window. When you select a frame, it shows highlighted
in reverse in the list, and it is shown as a border around the list of
frame styles. In the border and in the style list, large and intricate
frame styles are shown very tightly compressed (sometimes only
as a thick black frame), because the border and the list are too
small to show these patterns.

Do not select a style right now. You are going to produce the frame
illustrated below.
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4. Enter a size of 12.

Enter The New Size :

‘ 0K 3 ' l Cancel l

New Size 12
refers to the
width of the
frame
between the
arrows.

Frame size can be specified only in points. A frame size of 12
points is one pica (1/6 of an inch) thick from the inside edge to the

outside edge of the frame.
5. Click OK.

Element Selection

The Element Selection window shows a “blank” gray frame in the
border and eight elements in the center — four “corner” elements
and four side or “middle” elements. (See next illustration.)

E[J=== tlement Selection =—=|

Select an element:

6. Click once on the upper-left corner element to select it.
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7. Click OK for a 12 x 12 corner element.

The Frame Creation Process

The large box on the left side of the Frame Edit window is your
work area for creating and editing frame elements. (See next
illustration.) The small, empty box inside the work area is a blank,
12 x 12-point corner element, enlarged so you can work on it. A
blank actual-size corner element is displayed at the upper right.
The small, framed element display in the lower right shows which
element is selected.

8. Move the pointer inside your new corner element on the
left. The pointer changes to +.

E————rrne———
o

size: 12
Width: 12 Height: 12

<

Element:

Kl o

9. Click to enter a dot. (If a dot is not entered, the pointer is not
inside the corner element.)
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To delete a dot, click on it. You can click to enter or delete single
dots or drag to enter or delete a string of dots.

Start with the pointer on a white space to add dots; start with the
pointer on a dot to delete dots.

10. Experiment with entering and deleting dots. Try both
clicking and dragging to enter and delete dots.

The size you entered for the element you are experimenting with is
12 x 12; the element is 12 dots wide and 12 dots high.

11. To redesign your frame element, choose Clear from the
Edit menu, then continue.

When you are working on an element in the Frame Edit window,
Clear will erase only that element. To change the size of the frame,
you would have to close all the windows, going back to the Style
Selection window — not saving changes — and start over again
with New Style. Do not change the size for this exercise.

12. Now design a simple corner element for your frame.
Make the element asymmetrical so that you will be able to
see the effects of placing it in each corner. You may copy
ours on the next page if you wish.

You can observe the effect of your changes in the actual-size
element in the upper-right side of the screen. Your element needs
to have a pattern that you can recognize — other than that, design
to suit your taste.
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Our corner element looks like this.

=

frame bdit e

O

K2l

Size: 12
Width: 12

13. When you have made a simple design, close the Frame
Edit window.

You are returned to the Element Selection window and can now
select another element. Note that your new corner element is now
in all four corners of the frame around the window and has been
symmetrically rotated. The first time that you close the Frame Edji
window after designing a new corner element, the element is
placed in all the corners. This is how ours looks:

E[J=— Element Selection =Fic—

Select an element:

oC_J0J

NEW

oC_J0

Size: 12

3-10
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14. Select the middle element on the left side of the new
frame. The same dialog box as for corner elements appears.

15. Click OK for 12 points.

Twelve points gives you a square middle element, since your
overall frame has a size (width) of 12 points. The small empty box
in the Frame Edit window now represents a 12 x 12 middle
element. (See next illustration.)

16. Design the element.

As soon as you release the mouse button after entering the first
dot, your new side element will be replicated (placed repeatedly)
in the left side of the actual-size frame on the screen. Each time that
you change the element and release the mouse button, you will be
able to see the effect of your change on the whole side.

If you wish to see the effects of different middle elements, choose
Clear from the Edit menu and design a new middle element. Clear

will erase only the element that you are working on.

Here is our left middle element:

(RE—_—_—— — IirnnTn s ————
&
]

=]
Size: 12
Width: 12 Height: 12

5 Element:

17. When you have completed the design for the middle
element, close the Frame Edit window.
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The first middle element you design is rotated and /or flipped, and
placed automatically on all sides of the frame. Thus, you can
prepare a complete symmetrical frame by designing one corner
element and one middle element. This is how ours looks:

%Dg Element Selection =ie0u—"

‘ Select an element:

Size: 12

_ Close the Element Selection window. Click Yes to save thi
new frame. Close the Size Selection window to return to the
Style Selection window.

Tutorial: Editing a Frame

Frame styles that you design can be edited directly in Frame
Editor. When you edit a frame, the new version replaces the
original. If you want to keep both the original and the new versior
you must make a copy of the original using Duplicate from the
File menu before you start editing.

Note: Frame styles are stored in the XPress Data file, not in Frame

Editor, so saving a copy of Frame Editor itself, or duplicating
Frame Editor, will not save your frame styles.

3-12 CHAPTER 3: QUARKXPRESS FRAME EDITOR



The frame styles that are supplied with Frame Editor are locked
so that you cannot edit them directly. To edit a Frame Editor-
provided frame style, you must first make a copy of it using
Duplicate. (This procedure will be explained later in this chapter.)
You are permitted to edit a copy of a frame style provided

by Frame Editor but not the original. Remember, too, that
mathematically-defined frames can be neither copied nor edited.

Selecting a Frame to Edit
If you are not at the Style Selection window, return to it for this
tutorial. The frame that you just designed will be selected. You are
going to edit the newly designed frame.

1. If your newly designed frame style is not selected, scroll
to it and select it.

Notice that the frame you designed now surrounds the frame list.
Here is the frame we designed:

SEmm——— Style Selection

2. Click OK (or choose Open from the File menu or double-
click on the selected frame style).
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)

The Size Selection window gives you one or more size choices for
an existing frame. Since you designed your frame with a size of 12
points, that is the only selection that is offered here. The size will
not be changed in this editing exercise.

3. Double-click on the frame size (12) to select it and the
Element Selection window will be displayed. (You can also

go to the Element Selection window by clicking once on the
frame size to select it, then clicking OK or choosing Open from the
File menu.)

Selecting and Editing an Element

4. Click to select the upper-left corner element in the
Element Selection window.

[ECJ==== rlement Selection

Select an element:
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5. Click OK to leave the dimensions of the element
unchanged.

6. Make a few changes to the element.
If you do not like a set of changes, Revert in the Element menu

will change the element back to the way it was before you made
the changes. Here is our revised corner element:

=——————— Iy
B n

- —

Size: 12
Width: 12  Height: 12

6 Element:

K2l =

7. Close the Frame Edit window.

Closing the Frame Edit window takes you back to the Element
Selection window. You can select another element to edit, or you
can copy the results of your previous editing onto other elements.

Note that when you started a new frame, creating an element
caused that element to be placed symmetrically in all four
corresponding corners or sides. When you edited the element this
time, only the element selected for editing was changed; it was not
automatically copied into other positions as when first designed.

Copying Elements

Now you are at the Element Selection window. In the next steps
you will copy the element that you edited into the other corners.
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8. Choose Copy Elements from the Element menu.

Copy Elements —

Size: 12

0 ()

Choose Choose
e i 0] i1

Element Element

In the Copy Elements window, corner elements can be copied onl
to corner elements and middle elements to middle elements.

You will first copy your new element into the top right corner
of the frame.

The Choose From Element box at the lower left of your screen is
already selected, as shown by the dark border around the
element section.

9. Click on the upper-left element in the large box at the to
of the window. (This selects the element that will be copied — th

“from” element.)

Note that the upper-left corner is highlighted in the Choose From
Element box.

10. Click on the To button.
Now the Choose To Element box in the lower right is selected.
11. Click on the upper-right corner element in the large box.

Highlighting at the bottom of the screen shows the From and
To elements.

12. Click Copy in the lower-right section of the window.

Now you should be able to see the change in the frame.
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13. Click Copy & Flip to see what it does.

14. Click Copy to change the element back to the original
orientation.

If you cannot see the difference between Copy and Copy & Flip,
the reason may lie in the design of your element. Flipping
asymmetric elements makes a big difference, but flipping elements
that are symmetric makes no difference at all.

Now you will copy the same element into the other two corners.
You are still copying from the upper-left, so you do not need to
reselect the From element. The To function is still selected, as you
can see in the highlighting of the lower-right frame.

15. Copy your new element into the lower-left and lower-
right corners. The element you will copy from is already
selected (the upper left corner element). Select the element
you will copy to in the large box at the top of the window and

click Copy or Copy & Flip. Follow the same procedure for
each element.

16. Close the Copy Elements window to return to the Element
Selection window.

Now you can select a middle element for editing.

17. Select the left middle element. Click OK, leaving the
height dimension of the element unchanged.

18. Change at least one or two dots in the middle element.
19. Choose Revert from the Element menu.
When you choose Revert, the element returns to its original form.

A dialog box will ask if you wish to discard the changes for
this element.

C Do you want to discard the changes

for this element?
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20. Click OK if you want your original element back, or click
Cancel to keep your changes. (You will remain at the Frame
Edit window.)

When you are editing an element, your changes affect only one
corner or one side at a time. Similarly, Clear (Edit menu) and
Revert (Element menu) operate on an element-by-element basis
from the Frame Edit window. The Clear command works for the
selected frame size in the Size Selection window, and for all sizes
of the selected frame style in the Style Selection window. In the
Frame Edit window, Clear erases the element that is being worke
on. Be careful with the Clear command.

21. Edit the middle element in some way. Here is the way we¢
revised the middle element.

Size: 12

Width: 12  Height: 12

Element:

Kal [o

22. Close the Frame Edit window.

Closing the Frame Edit window returns you to the Element
Selection window, where you can either select another element to
edit or choose the Copy Elements command.

23. Choose Copy Elements from the Element menu.
Now you will copy your edited middle element into the other

three positions to complete your frame. The Choose From Elemer
box at the lower left of your screen is already selected.
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24, Click on the left-middle element — the “from” element —
in the large box at the top of the window.

25. Click on the To button.
26. Click on the upper-middle element in the large box.

27. Click Copy in the lower-right section of the window. (Now
you should be able to see the change in the frame.)

Instead of copying the element, you can tailor the design of
each side if you wish by selecting and editing each element
individually. You can also tailor each side by using Copy & Flip
selectively.

28. Continue copying the new middie element to the two
remaining locations. The left middle element remains
selected in the From box, you need only click on the right
middle element in the large box, then click Copy. Click next
on the lower middle element and then click Copy.

The screen below shows our changes.

= Copy flements
RO O

Size: 12

Choose E """"""""""" Choose
i_i i_i

Element | j Element

For some frame styles, the patterns will work out and connect up
correctly in one size but not in another size. In some sizes the
frame may show irregularities when the elements are replicated.
Owing to the resolution of the screen, some irregularities that
show in the picture of an entire frame style on the screen do not
show when the frame is printed on a printer that has high
resolution.

29. Close the Copy Elements window.
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Saving Changes

If you save the changes to your frame, the new frame will replace
the original. If you do not save the changes, the edited frame will
be discarded and the original will be retained. If you save a frame,
it will remain in the list of available frames.

30. Close the Element Selection window. You will be asked if
you want to save your frame.

31. Save the changes to your frame. Click Yes.
272. Close the Size Selection window to get back to the Style

Selection window. Your new frame will appear at the top of
the selection list.

Clearing a Frame

If you do not want to keep a frame, select the frame in the Style
Selection window. Then choose Clear from the Edit menu. In the
Style Selection window, Clear will remove an entire frame style
and all its sizes.

Tutorial: Frame Design with Elements of
Unusual Shape

In previous sections you worked with frames that had elements
with equal length sides. In this section you will explore a few
variations on element shape to see how to implement different
design ideas. You will produce a set of design elements that look
like the illustration below.

F====== Style Selection

| ||

%
EIIHHIIIIIH
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1. When you are at the Style Selection window, choose New
Style from the File menu.

2. Enter a new Size of 18 (18 points) for the overall frame
and click OK.

Specifying a larger size makes it possible to design a more complex
frame style, because more dots are available for each element.

3. Select the upper-left element.

4. Specify a Height and Width of 32 points for the corner
element and click OK. When the Frame Edit window
reappears, do not enter any dots in the element.

Corner Elements: Equal Height and Width

Specifying a height or width larger than the frame size makes it
possible to design a corner that extends farther out into the sides of
the frame. The L-shaped white area in the left of the Frame Edit
window is the corner element. The gray area is not part of the
element. The element is L-shaped because you specified a frame
size (width) of 18 and an element size of 32 x 32. The element is 18
points across each end and 32 points along its top and left edges.
This element just fits in the work area.

5. Close the Frame Edit window, which returns you to the
Element Selection window.

Frame Edit

Width: 32 Height : 32

Element :
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Corner Elements: Unequal Height and Width
6. Select the same upper-left corner element.

7. Specify a height of 44 points and a width of 56 points,
and click OK.

Height:
Width: -

' Us ' Cancel

The diagram below shows the relationship of the dimensions that
you specified for the corner element with what you see on the
right side of the Frame Edit window. Both ends of the corner
element are the overall thickness you specified (18 points), the
height you specified is along the left edge of the element (44
points), and the width you specified is along the top edge of the
element (56 points).

56 points wide

a
h
-_‘

frame size 18 points

Only part of this larger element fits in the work area. The work
area is identified by the dashed square on the right. (See
illustration below.) If you specify an element that is larger than
the editing work area, you must scroll to reveal the hidden parts
of the element.

Size
Width: 56  Height: 44

Element:
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Whenever part of the element is not shown in the work area, one
or both scroll bars around the work area are activated.

8. Experiment with the scroll bars to see how to view the
remainder of the element.

Notice how the dashed square superimposed in the box at the
right changes to show the part of the element being viewed.

9. At each of the six corners place a 4 x 4 dot pattern like
this one:

The purpose of placing the 4 x 4 dot pattern in each corner is to
enable you to see where each design element will be located in
the frame.

10. Outline the design element with a one-dot-deep border.

The result should be similar to the next illustration. Be sure to
scroll into each end of the element and into the inside corner.

Frame Edit

Size: 18
Width: S6  Height: 44

]

Element:

11. Close the Frame Edit box.
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Your Element Selection window should look like the
illustration below.

ECJSSSi== Element Selection
Select an element:

OC

NEW

Size: 18

jaemsl
Q0]

If you want to rearrange the way the longer and shorter ends of
the element project, use Copy & Flip in the Copy Elements
window. If you wish, you can define the dimensions of each corne:
element separately and design each element from scratch.

Middle Elements

Let's experiment briefly with the effects of different dimensions of
middle elements.

12. Select the left middle elemant.

13. Type 9 for the height and click OK. (This gives you an
element with 9 points along its left edge.)

14. Draw a horizontal line one dot thick across the middle of

the element. Your Frame Edit window should look like the
illustration below.

&

Size: 18
Width: 18 Height: 9

[l

El
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15. Close the Frame Edit window to return to the Element
Selection window.

Note that the top and bottom portions of the frame appear to have
a set of bars darker than the rest. This frame must be viewed full
size to see how it will actually appear.

16. Choose Display Full Size from the Special menu.

The Full-Size Frame Display shows the frame in proportion
without distortion.

17. Close the Full-Size Frame Display and return to the
Element Selection window.

Now we will modify the dimensions of the middle elements
to see what effect this has on each element and the frame’s over-
all appearance.

18. Select the top middle element, type 36 for width, and
click OK. (This gives you an element with 36 points across its
top edge.)

H

Size: 18
Width: 36  Height: 18

Frame Editor expanded the element design proportionally to fit
the new shape. Since you have made the element four times wider,
the orie-pixel-wide line becomes four pixels wide. In order to
follow your instruction and fit everything in, Frame Editor made
the line wider.

Depending on your design goals and the type of element, this
resizing may not be what you want. The final appearance of
your frame is determined by the relationship between the size
of the frame, the size of the box that it borders, the number of
element repetitions, and the width and height of the corner and
middle elements.
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For this exercise, you can now edit the line in the Frame Edit
window to a narrower one, or leave it as it is.

19. Close the Frame Edit window.

Next you will edit the right middle element.
20. Select the right middle element.

21. Type 3 for height and click OK.

The element is now 18 points wide and 3 points high, as you
specified. Note how the element is changed to fit.

22. Close the Frame Edit window.

23. Select the Special menu and then choose Display
Full-Size.

Note that the frequency of repetition of middle elements can be
altered by changing their dimensions.

ull-Size Frame Display ===

Size: 18

IlllllllilllllllllIIIII!__L]_i
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24. Close the Full-Size Frame Display window.

25. Close the Element Selection window and click Yes, to

save this frame. You will be returned to the Size Selection
window. Close the Size Selection window and you will be
returned to the Style Selection window.
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Tutorial: Viewing Frames Full-Size

Frame styles can have many sizes. When you specify a frame
size that does not already exist for a particular style, the new
size is created by scaling an existing size. All frames in the Style
Selection window are shown actual size up to 12 points.

In order to become familiar with the actual appearance of the
tightly compressed large frames in the Style Selection window,
you should view these frames full size at some point while you are
using the Frame Editor.

1. Select a style from Style Selection. Click OK.

2. From the Size Selection window, click on the size shown
to activate it. Click OK.

3. While viewing the Element Selection window on your
screen, select the Special menu and choose Display Full-Size.

You will notice that the appearance of many of the frames is
entirely different when expanded to full size.

4. To quit this section, close boxes until you are back to
Style Selection.

Tutorial: Rescaling Frames

If you wish to use a frame in a size that is not already available,
you can rescale the frame either in QuarkXPress when you put the
frame on a box, or you may create the desired size in Frame Editor.
When the frame is rescaled, some aspects of its design may be
distorted. However, if you create the new size in Frame Editor, you
can clean up the distortion.

You can change the size and otherwise edit frames that you have
designed, but the frames supplied with QuarkXPress are locked by
Frame Editor against direct editing. You must first copy a

locked frame and then make changes to the copy. This safeguards
the originals.
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Changing the Size of a Locked QuarkXPress
Frame, Making a Duplicate

A frame that is locked by QuarkXPress: To make a new frame
that is different only in size, you must first copy the frame as
described here. Then follow the procedure for changing the size of
a frame you have designed (an unlocked frame).

1. Select the locked frame we have selected below. Click OK

[E====== style Selection —r——

2. When you see the Size Selection window, select New Size
from the File menu. When you attempt to change the size of a
frame locked by QuarkXPress, you will receive the following
message.

0 This frame is locked.

3. Click OK to get back to the Size Selection window. Close the
Size Selection window and return to the Style Selection window.

4. Highlight (click once on) the QuarkXPress frame to
be copied.
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5. Select Duplicate from the File menu. The selected frame
style, along with all its sizes, is duplicated. The new copy will be
highlighted in the frame style list.

. Click OK and proceed to Step 1 of the tutorial below
for frames not locked by QuarkXPress and make the new
frame size.

Note: You may also edit this duplicate frame in any way you wish
by following the instructions for “Editing a Frame” at the
beginning of this chapter. If you are making stylistic changes to the
frame instead of simply creating new sizes, you may wish to
remove all sizes of the frame except for one, make changes to that
single size of the frame, and then make new sizes from the edited
version. To remove frame sizes, select a size from the Size Selection
window and select Clear from the Edit menu.

Changing the Size of a Frame You Have Designed
To make a new size frame for an existing design, follow these steps.
1. Inthe Style Selection window, open the frame style.

2. When the Size Selection window appears, choose New
Size from the File menu.

3. Enter the new size and click OK. Frame Editor will scale the
frame to the new size and take you to the Element Selection
window.

4. To simply save the new size — without any other
changes — close the window and click Yes in the dialog box.
The scaling of the frame to its new size may cause distortion. You
can use Frame Editor to clean up the new size, following the
procedure for frame editing.

5. You will see the new size added to the selections
available in the Size Selection window.
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Using the Scrapbook to Design a Frame

The Scrapbook may be used to assemble a new frame from
elements of existing frames. This new frame may have corner
elements from one frame style and middle elements from
another. To assemble this type of frame, copy one element for the
corner and one element for the middle of the new frame, each fro;
a different frame. Copying these elements and pasting them into
the Scrapbook is a quick way to combine elements from existing
frames into one frame. Note that the widths of the various
elements must be equal or they will not line up correctly.

Frame Editor Reference

Menus

After you have completed the tutorials, use this section for
reference when using Frame Editor. You may also summon on-lin
help by selecting About Frame Editor from the ¢ menu when
the Frame Editor is open. Remember that frame styles are stored
in the XPress Data file, not in Frame Editor, so saving a copy of
Frame Editor itself, or duplicating Frame Editor, will not save
your frame styles.

Four menus are available in Frame Editor: File, Edit, Element, an
Special. Varying options in the menus are available from differen
Frame Editor windows.

When the Style Selection window is open, the New Style
command is available in the File menu. When the Size Selection
window is open, the New Size command takes the place of the
New Style command in the File menu.

Items that can be opened with the Open command in the File
menu also vary for each window. For example, you can open a
selected frame style from the Style Selection window, and you ce
open a selected size from the Size Selection window.

The choices in each menu are described below. The equivalent
keyboard commands are given when available.
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The File Menu
The following choices are available in the File menu:

New Style, 32-N, enables you to create a new frame style (available
when the Style Selection window is open).

New Size, 3-N, enables you to create a new frame size. Sizes
are always specified in points; each dot in a frame element is a
1-point square (available when the Size Selection window is open).

Open, -0, opens whatever is selected or available to open.

Duplicate, 33-D, copies whatever frame is selected and adds it to
the Style Selection window. Duplicate may be used to copy
locked QuarkXPress frames or any frame you wish to edit; the
original will be kept intact.

Quit, 32-Q, whenever available, exits from the Frame
Editor program.
The Edit Menu
The commands in the Edit menu operate on the selected item or

the contents of the Scrapbook in the same way that they operate in
QuarkXPress and other Macintosh applications.

UNdOisisiniind 8-Z
Cutiammaas #8-X
Copy...coverurenranns #-C
Paste.......coxmusnversd ®-V
Cleat.. s (no keystroke command)

In the Style Selection window, Clear removes an entire frame
style and all its sizes.

In the Size Selection window, Clear removes a selected size of a
frame style.

In the Frame Edit window, Clear erases the element that is being
worked on.
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The Element Menu

Copy Elements is available from the Element menu at the
Element Selection window. Copy Elements allows a selected
element to be copied to its corresponding positions in a frame.
For example, a corner element can be copied to other corners.

Revert, 2-R, returns an element to the original condition, prior to
the beginning of the editing session.

The Special Menu
Display Full-Size (from the Special menu) is available in the

Element Selection and Frame Edit windows and shows the
selected frame full size.

Summary of Procedures

This section reviews the steps to take to use the various features of
the Frame Editor.

After you open the Frame Editor icon, you will find yourself at

the Style Selection window. There you can select a frame to edit,
create a new frame, or delete an entire frame style and all its sizes.

To Create a New Frame Style

1. In the Style Selection window, choose New Style from the
File menu.

2. Enter the overall size of your new frame. Click OK.

3. In the Element Selection window, select an element to create;
change the height and width for the element, or leave the
dimensions the same as the frame size. Click OK.

4. Create the element and close the Frame Edit window.

5. Create any other required elements by following steps 3

and 4. You must create at least the corner element and one
side element.
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6. Close the Element Selection window. Click Yes to save
the changes.

7. Close the Size Selection window, and you will find your new
frame in the Style Selection menu.

To Edit a Locked Frame
To edit a locked frame style, you must first copy the frame using
Duplicate from the File menu. The copy will appear selected at the

bottom of the Style Selection window. Then proceed as described
below for unlocked frames.

To Edit an Unlocked Frame

1. Select the frame style in the Style Selection window. Select
the size and element to edit.

2. After you have edited the first element, you may copy that
element into other positions or edit another element.

You may edit a corner (or middle) element and then use Copy or
Copy & Flip to put that element in all corner (or middle) locations,
or you may separately edit each element to create a frame with a
different design in each location.

3. Close the windows or choose Quit — saving your edited
frame or not.

Remember, if you wish to save both the original frame and the
edited version, you must select Duplicate from the File menu
before beginning the editing session.

To Change the Size of a Locked Frame
To change the size of a frame locked by QuarkXPress you must
first copy the frame using Duplicate from the File menu. Then
proceed as described below for unlocked frames.

To Change the Size of an Unlocked Frame

To make a new version of an unlocked frame style that is different
only in size:

1. Select the frame style by double clicking on it.
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4.

When the Size Selection window appears, choose New Size
from the File menu.

Enter the new size and click OK. The computer will scale the
frame to the new size and take you to the Element Selection
window. You can then edit the elements of the frame to clean
up any distortion introduced by the scaling process.

Close the Element Selection window and click Yes to save this
new size. You will see the new size added to the Size
Selection window. You can quit, or close windows to return

to the Style Selection window.

To Copy an Element

1.

2.

Select first the frame style and then the frame size.

Choose Copy Elements from the Element menu and click to
identify the element that you want to copy.

Click on the To button, then click to show where you wish to
copy the element. Click Copy or Copy & Flip.

If you want to copy this same element to other places, click in
the pattern to show the next place where you wish to copy the
element. Click Copy or Copy & Flip.

. Continue with this process until you have copied the

required elements.

Click the close box to return to the Element Selection window,
where you can select a new element to edit, or close the
windows, or choose Quit — saving your copied frame or not.

To Quit the Frame Editor

3-34

The only window from which Quit is not available is the Copy
Elements window. If you are currently editing a frame, you will b
given the opportunity to save or discard your work before exiting
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arge, uppercase
characters set into
a body of text are

| called initial caps.
: Initial caps help
to break up large
blocks of text. They
can be used to start a story, to start a
paragraph, or to
help guide the i $
reader'seyetoa baga
particular point. o]

Initial caps can
be versions of the
display or body text
modified using
the Style menu in
QuarkXPress, ar
they can be de-
signed with a {
graphics pro- -
gram, and then
imported into a document
as a picture.

Drop caps are set within the body
text. Drop caps should align at top
with the cap height of the first line of
the body text and with the baseline of
the bottom line adjacent to the inset.
Text can be run around the contour of
the drop cap character, or text can be

blocked out around the drop cap.
Raised initials align with the base-
line of the first line of text, and are
easiest to create. If the initial cap is a
word (like ‘A" or ') be sure to set
enough space to the right of it so the
reader is not confused by the effect.
Raised initials are a useful and
easy-to-implement
design element.
Paragraphs con-
taining raised ini-
tials must have
leading set to an
absolute value, as
the larger type
face will throw off
the leading of the

] first two lines.

g Hanging caps

y are not as common

as the other initial

cap designs. Place a hanging cap

in the margin against type which is set
flush (left justified).

Another way to create blocked-
in caps is by simply placing the
drop character box in the correct
position without making the box
transparent. Continue by adjusting
drop character size and leading,
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Type as a Design Element

The word type comes from the Greek word typos, meaning letter or
letter form. Type is a design element. But aesthetic appeal should
not be the only consideration when applying type to a design.

Through the years certain rules and conventions about how type
should be set have developed. But depending upon design objec-
tives — these rules can, and should, be broken from time to time.
There are, however, some broad objectives which should be
adhered to when setting type: it should be legible, readable, attrac-
tive and meet the design requirements.

As typesetting has evolved from traditional hot lead type to
images on a video screen — so has the terminology used to
describe type. Electronic, or desktop, publishers have begun to
develop a nomenclature of their own. In some cases terms have
carried over from old-time hot typesetting. But many of the terms
used by desktop publishers are different from the terms used by
traditional typesetters. In fact some words used to describe hot
lead type mean something completely different to desktop pub-
lishers. In an attempt to avoid confusion, we distinguish between
traditional typesetting terminology and current usage.

Typography is a craft. A typographer designs with type; a typeset-
ter makes type fit designs. Because computers don 't design (not
even the Macintosh), people do — the following sections are
devoted to giving beginning designers some tips on basic design
with QuarkXPress. Seasoned designers and typographers may
pick up some pointers about how to implement some of their
favorite design elements using the program. Beginners should find
the following sections helpful in creating good-looking, well type-
set documents with QuarkXPress.
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Typographical Measurement

Typography in the U.S. is based on a system of measurement
known as the American point system. This system uses points and
picas as the units of measure.

Before electronic publishing, a point was equal to just less than
1/72 inch (72 points = .9961 inch). The system was simplified for
the Macintosh so that there are exactly 72 points per inch.

The pica is used to measure horizontal line space. There are six
picas to an inch, 12 points in a pica. Line length, for example, is
generally measured in picas.

Today there are three major typographical measurement systems
throughout the world: Points/Picas, (used mainly in the U.S.) the
Didot System (which has been the measurement system used in
most of Europe) and the metric system.

The Didot System has the cicero as its basic unit. One cicero equals
12 corps, or .178 inch. One corps equals .01483 inch.

The metric system is slowly becoming the standard measurement

system worldwide (except the U.S.). In the U.S,, typesetters and
designers use the point/pica system almost exclusively.

IN\H\HHW?I! s ‘\HHHW‘
| \

one inch
1inch = 72 points = 6 picas

6 picas

CHAPTER 4: TYPOGRAPHY AND DESIGN



Em and En Space

Points and picas are used to measure type size and line length.
Typographers use another measurement system to measure space
within a line. Traditionally, this system was based on the lowercase
“m” character in a particular font, hence the term “em space”.

In QuarkXPress an em space is the width of two zero characters “00”.
A smaller unit, the en space is one-half the width of an em space. In
QuarkXPress an en space is the width of one zero character “0”.

Tracking and kerning functions are measured in fractions of an em
space. The program tracks and kerns to .005 (1/200) of an em
space. Entering a value of -10 for kerning in QuarkXPress, for
example, means that 10/200ths (or 1/20th) of an em space is being
shaved from between the character pair.

f \ £\
\ / \ ¥ J

72-point Helvetica 72-point Helvetica
Em Space En Space
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Glossary of Typesetting Terms

cap height

baseline

Many terms which have found their way into desktop publishing
originated in the days when type was set with hot lead characters.
Some desktop publishing terms were used in old-time typesetting
but have entirely different meanings in a desktop publishing envi-
ronment. The following glossary defines many of the terms used
by desktop publishers today.

serif
ascender

x-heigh

descender serifs

Ascender is the part of the lowercase letter which rises above the
x-height, as in the letters b, d, f, h, k, I, and t.

Baseline is the line upon which uppercase and most lowercase
characters sit.

Descender is the part of a lowercase character which drops below
the baseline: p, 9, y,j, and g.

Display Type is type which is more than 14 points high from
ascender to descender. Display type is generally used for headline:
and advertising copy.

Em Space in traditional typesetting meant a square of a given
point size. A 12-point em would be a square of 12 x 12 points. An
em space in QuarkXPress is the horizontal space taken up by two
zeros, “00” in a given font. QuarkXPress kerns and tracks in incre-
ments of .005 (1/200) of an em space. Kerning and tracking use the
em space as the basic measurement unit.

En Space is one-half the width of an em space. In QuarkXPress, an
en space is the width of the character “0” — or one-half an em space

Font in desktop publishing has the same meaning as typeface to tra
ditional typesetters. A font is a set of characters with the same
basic design.
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Font Size is defined by the font designer, and its measurement fol-
lows no hard and fast rules. Generally, font size reflects the space
between the tallest ascender and lowest descender in a given font.

Kern means to adjust the amount of white space between letter
pairs. The term can be used both as a verb and as an adjective. Letter
pairs can be kerned to 1/200 of an em space with QuarkXPress.

Key Caps is the desk accessory (located in the Apple Menu) that
determines the particular keyboard mapping for the font you are
using. When you open Key Caps, a menu item containing a list of the
fonts in your system is displayed at the right end of the menu bar.
Scroll down and select the font you wish to examine in Key Caps.

Leading used to mean the space between lines, but in desktop pub-
lishing the term has come to mean the measurement of space from
baseline to baseline. A leading value includes the font size plus the
space between lines. Leading has taken on the same meaning as the

traditional typesetting term, linespace.

Letterspacing, the horizontal space between letter pairs, is
adjusted by tracking in QuarkXPress. Positive tracking values
increase letterspacing, negative tracking shrinks the space
between selected characters.

Linespacing is a traditional typesetting term which has been replaced
by the term leading in desktop publishing.

Pica is the base measurement in American typography. There are six
picas to an inch.

Point Size measures the size of type from the top of the ascender to
the bottom of the descender. There are 12 points to a pica, or 72 points
to the inch.

Serifs are the short strokes which project from the main strokes of a
character. Sans serif (without serif) fonts have the same weight and
thickness throughout.

Text Type is smaller than 14 points. Text type is used to set large
blocks of text. You are currently reading text type.

Tracking allows adjustment of white space between selected charac-
ters and words. By specifying positive or negative tracking values,
overall letterspacing can be adjusted.
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X-Height is the size of the lowercase “x” in a typeface. The term
refers to the size of the main element of the character. X-height is
not the same as the font size. Font size is a combination of x-heigh
plus the length of the ascender or descender. The larger the
x-height, the shorter the ascenders and descenders.

Choosing the Correct Font

Choosing a font can be a difficult task. What shape should it be,
how big, how bold, how tight, how straight?

To start with, there are two basic designs for type — serif and
sans serif. A serif is a stylized short stroke which projects from
the main stroke of a character. While the serif is a holdover from
when ancient Romans were typesetting onto monument walls
with chisels, it turns out serifs are useful embellishments. The
short thin strokes serve as pointers to guide the reader s eye
toward the right.

Some fonts are designed for use as display type (headlines), other:
are better as text type (body). Each font has a different effect on the
reader; some evoke a feeling of authority, others give a playful
look to the finished page — but each was designed with a specific
use in mind.

While literally hundreds of fonts are available for electronic
publishing, there are only a few basic groups of fonts. A good
working type library might include only one or two fonts from
each of the families.

Most laser printers and phototypesetting devices for the Mac-
intosh use fonts which have been described in the PostScript page
description language. Unlike fonts designed for use on dot matrix
printers like the ImageWriter, PostScript fonts are not defined
with bitmaps. The curves and lines of PostScript fonts are defined
mathematically, resulting in characters with sharp, clean curves
and edges.

The fonts shown in the examples which follow are PostScript fonts
from the major font groups. The fonts listed here are available fron
Adobe Systems, Inc. These are only samples; there are many fonts
from each family currently available for the Macintosh.
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Major Font Groups

Modern Serif

Characterized by a sharp contrast in thick and thin strokes with lit-
tle or no serif bracketing (joining the serifs to the stems), type from
this family is ideal for large blocks of text — though the bold mem-
bers of the family are better for shorter text blocks.

New Century Schoolbook

The quick brown fox jumps over the lazy dog.

Baskerville

The quick brown fox jumps over the lazy dog.

Old Style Serif

Old Style fonts are characterized by strokes of uniform thickness.
Serifs usually are joined to the stem with curved brackets. Fonts
from this family work well as either display or text type, but are
best suited for large blocks of text, such as book or magazine copy.

Garamond
The quick brown fox jumps over the lazy dog.

ITC Bookman
The quick brown fox jumps over the lazy dog.

Square Serif

Square Serif fonts feature blocked serifs and little contrast between
the vertical and horizontal strokes. Square serif fonts hold up well
under poor printing conditions. While square serifs can be used as
text type, they are better suited for display type and short blocks of

advertising copy.
ITC Lubalin Graph
The quick brown fox jumps over the lazy dog.
Glypha

The quick brown fox jumps over the lazy dog.
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Sans Serif

Fonts from this extensive family are usually of the same thickness
and are visually equal in weight throughout each character. Varia
tions of sans serif fonts — from ultralight to extra bold — make
good display type, especially when surrounded by white space.
While the simple design of sans serif fonts often adds impact to a
page, large blocks of sans serif text can strain the eye and be diffi-
cult to read. Even so, sans serif fonts are quite versatile and are
useful in a wide variety of applications.

Helvetica
The quick brown fox jumps over the lazy dog.

ITC Avant Garde Gothic

The quick brown fox jumps over the lazy dog.

Modified Serif

Script

Almost without serif, a Modified Serif font is more freely designe
with a greater variation of thick and thin strokes, than a sans seri
font. The modified serif may be a slight flare to a character’s tail,
a stylized point to its foot. The subtle serifs from the modified ser
family tend to guide the reader’s eye and make the type more
readable in large blocks than sans serif type.

ITC Souvenir
The quick brown fox jumps over the lazy dog.
Optima

The quick brown fox jumps over the lazy dog.

Script fonts are calligraphic in design; their connecting characters
resemble fine penmanship. Use script fonts sparingly, and only fc
the most formal typesetting jobs. Script fonts should never be us¢
in all uppercase.

ITC Zapf Chancery
The quick brown fox jumps over the lazy dog.

@ﬂ'{ﬁ O‘qvenuz
The qut’c£ broun fox /u.m)bs over the [azy dog.
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Pi Fonts

Pi fonts contain graphic elements used in typesetting. A typical pi
font has boxes, bullets, check marks, and other graphic devices.
Some pi fonts have characters for specific uses such as cartography
or scientific notation.

I'TC Zapf Dingbats
x sk D@siokk OTINME ©01 £ 00TA Ue50 Wik @OM H1%

Carta
oL ol Foe 100a% w0 4 E0¢ Omk0 Ok Ted ) AO4

Punctuation for Typeset Documents

Some of the rules taught in high school typing class do not carry
over to typesetting. Many of the differences stem from the fact that
the typewriter keyboard is much more limited than keyboards
available to typesetters, or to someone using a Macintosh for
electronic publishing.

If you want the material you prepare with QuarkXPress to have

a professional typeset look, use the rules and conventions
developed for typesetting. Learning the rules and incorporating
them into your typeset work is easy — in fact, using them becomes
automatic in no time. The text in this section and the examples
which follow outline some typesetting rules and illustrate how to
implement them using the Macintosh keyboard.

Typewriter typists are told to insert two spaces after a period.
When typesetting, use only one space. You should never hit the space
bar twice in a row when typesetting. The space bar is only for spacing
between words — not moving across a line. Set and use tabs if you
wish to move to the right.
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Some of the punctuation keys found on the Macintosh keyboard
are typewriter characters, not typesetting characters. When using
single and double quotation marks or apostrophes in typeset
work, use the typeset punctuation instead of the regular Macintos
keyboard characters. Punctuation characters for typesetting are
shown in the table on the next page. Some fonts may place charac-
ters somewhat differently than others. If you should have trouble
locating these, use the Key Caps desk accessory to check keyboard
mapping for the particular font.

A ligature is a pair of narrow characters which have been com-
bined as one character. Though their use is not as widespread as it
once was, ligatures can still be found in elegant typesetting. Some
fonts have certain ligatures built-in. The pairs fi and fl are example
of ligature characters. Check Key Caps for the font you are using. |
may be possible to simulate a ligature pair which does not exist in
the font by employing negative kerning to reduce the space
between character pairs.

Dashes (—, -) and the hyphen (-) are different characters. Never
use a double hyphen () to represent a dash.

The long dash (—) is used for interpolation, summation, explana-
tion or interruption — it is the dash used for punctuation. A dash
should not begin a line; if possible, use tracking to move a dash
back to the end of a line.

The short dash (-) is properly used in ranges, in compound modi-
fiers and as a hyphen in uppercase headlines.

Ellipses (...) are used to indicate a pause in a sentence. They
should always contain three dots — not more, not less. Most fonts
contain ellipses as a pre-defined single character; check Key Caps
to locate the correct key sequence. The pre-defined ellipsis points
are spaced too closely for some typesetting purists. So to set a mor
traditional ellipsis, type three periods and separate them by using
positive tracking.
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Special Typesetting Characters

Special Typesetting Characterst

Character Name

breaking standard space*
non-breaking standard space*
breaking en-space*
non-breaking en-space*

breaking standard hyphen
non-breaking standard hyphen
short dash*

long dash*

discretionary (soft) hyphen

opening double quotation

closing double quotation

opening single quotation

closing single quotation or
apostrophe

Character

(width of a space)
(width of a space)
(width of a digit)
(width of a digit)

Key Sequence

space
$-space
Option-space
#-Option-space

hyphen

3:‘-:

Option-hyphen
Option-Shift-hyphen
$2-hyphen

Option-[
Option-Shift-[

Option-]
Option-Shift-]

t Keyboard mapping may differ in some fonts. Check Key Caps for the particular font if you

have trouble locating a character.

* Width depends on font in use.
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Dashes & Hyphens

Hyphen (-)
Do not use a double-hyphen (--) to represent a dash (—).
Breaking Words
The hyphen is used for dividing words at the ends of lines.
Compound Words

Use hyphens for connected (e.g., mother-in-law) or compound
words (e.g., top-of-the-line).

Long Dash (—)

The decision whether to place spaces between dashes and the
words they separate is one of style. While it used to be that no
space was set — more and more, typesetters are spacing between
words and dashes. Consistency is the only hard-and-fast rule.

Avoid beginning a new line with a dash. If the dash is wrapped ont
a new line, use tracking to back the dash up to the end of the previ-
ous line. A way to keep dashes from wrapping to a new line is to

place a non-breaking space before the dash (see the table on p. 4-15)

Explanation
This type was produced with QuarkXPress and a photo-
typesetting printer — a device which uses laser optics to
set images onto photographic paper or film.
Interpolation
QuarkXPress and a phototypesetting printer — a device
which uses laser optics to set images onto photographic

paper or film — were used to produce the crisp, clear type
you are reading now.

CHAPTER 4: TYPOGRAPHY AND DESIGN



Interruption

“You produced this with QuarkXPress, why it's ... it's —"
“It"s professional,” interjected Kristin.

Summation

Type, white space, and graphics — these are the elements
of publication design.

Short Dash (-)

Compounds

Use the short dash to signify division between hyphenated com-
pound modifiers.

the Colorado Springs—Denver-Boulder corridor
cost-of-living—salary-based adjustments

Headlines

Hyphens sometimes appear too small in all-uppercase headlines,
and should be replaced by short dashes.

QUARKXPRESS FEATURES TOP-OF-THE-LINE
TYPESETTING

Ranges
Use a short dash instead of a hyphen to separate numerical ranges.

the Reagan years, 1980-1988
60-90 days
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Creating Emphasis

There are a number of ways to add emphasis to text. Emphasis,
when used effectively, can help increase legibility and under-
standing. When used incorrectly, it can ruin the look of a page
and cause confusion.

First, underlining is often an undesirable method of adding
emphasis to typeset work. With the typewriter, the only way to
add emphasis to text is to use underline. Typesetters, however,
have many other better-looking ways of emphasizing text. By
changing the font style, size or weight, text which requires empha-
sis can stand out from body text.

Use of italics is the most common and probably the most pleasing
way of creating emphasis especially within display type. Use of
italicized text does not affect the overall appearance of the printed
page; its use creates emphasis without distracting the reader. Any
punctuation which follows an italicized phrase or sentence should
also be italicized.

Creating emphasis through use of bold type is effective in modera-
tion, especially within display type. Bold type attracts more atten-
tion than other methods of emphasis. Too much bold text causes
pages to be too dark and may have a negative effect on legibility.
Nonetheless, for emphasizing a few words at a time, there is not a
better style for attracting attention than bold face type within a
larger body of plain text.

Use of all uppercase characters can be an effective, assertive means
of adding emphasis. All caps, however, are more difficult to read
than lowercase letters, and should be used sparingly.

ltalics
Use of italicized text does not affect the overall appear-
ance of the printed page, its use creates emphasis with-
out distracting the reader.

Bold Face

Creating emphasis through use of bold type is effective in
moderation. Bold type attracts more attention than
other methods of emphasis. But, too much bold text
together causes pages to be darker and may have a nega-
tive effect on legibility.
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All Caps

Use of all uppercase characters can be an EFFECTIVE,
ASSERTIVE MEANS OF ADDING EMPHASIS. All caps
are, however, more difficult to read than lowercase letters,
and should be used sparingly.

Underlining

First, underlining is often an undesirable method of
adding emphasis to typeset work. With the typewriter,

the only way to add emphasis to text is to use underline.

Boxes, Bullets and Other Graphic Devices

Qoaa

¥* v = A

Boxes and bullets are used to emphasize items in a list. Most fonts
have closed bullets available. Boxes, open bullets, and other graphic
devices can also be found in fonts such as Adobe’s Zapf Dingbats.

Boxes and bullets should be as close as possible in size to the
x-height of the line they emphasize. If you select a closed bullet or
other graphic device from the same font as the type being empha-
sized, it should already be the proper size. Boxes or bullets taken
from a graphic font might need to be resized to approximate the
x-height of the emphasized text. If they are too large, boxes and
bullets tend to stand out and distract the reader from the type
being emphasized. Too small, and emphasis is lost.

Magazines and journals often use boxes, bullets, or other graphic
devices to signal the end of a story.

Closed bullet
Open bullet

Open box
Closed box
Other graphic devices

ITC Zapf Dingbats
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Paragraph Indications

Readers need to be shown when new paragraphs begin. The most
common method of indicating new paragraphs is a paragraph
indent. The best space for an indent varies according to line length
indent one em space for lines under 24 picas long, 1.5 em spaces
for lines of 25-36 picas, 2 ems for lines of 37 or more picas.

There are other methods of indicating the start of new paragraphs.
Paragraphs can be separated with space — by at least a half-line,
but usually a full line or more. If the space method is used, the eas
iest way is to place two carriage returns — one at the end of the
paragraph, one between paragraphs. This double carriage return
method inserts space between paragraphs, while leaving leading
unaffected when matching lines in columns.

In QuarkXPress, the Space Before and Space After values (found
under Paragraph Formats) combine to produce the space between
paragraphs. In order to produce the best results, use absolute lead-
ing and a combined Space Before/Space After value which equals
the absolute leading value.

Another less common method of indicating paragraph changes is
through use of a typographical device such as the paragraph mark “{".
An elegant graphic device, or one which relates to the text can be a nice

touch to a typeset page.

Negative first line indents (or hanging indents) are commonly
used to mark paragraphs in reference material such as dictionaries
bibliographies, etc. Poetry and children”s books make use of this
style, often indenting the entire first word. To produce this effect,
enter a negative value in the First Line field (and an equal amount
of positive leading in the Left Indent field) of the Paragraph For-
mats dialog box.
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Examples of Paragraph Indications

First Line Indent of One Pica

Readers need to be shown when new paragraphs
begin. The most common method of indicating new para-
graphs is a paragraph indent — usually about one em in
length, longer for wide paragraphs.

There are other methods of indicating the start of new
paragraphs. Paragraphs can be separated with space —
by at least a half-line, but usually a full line or more.

Full Line Space (double carriage return) Between

Readers need to be shown when new paragraphs begin.
The most common method of indicating new paragraphs
is a paragraph indent — usually about one em in length,
longer for wide paragraphs.

There are other methods of indicating the start of new para-
graphs. Paragraphs can be separated with space — by at
least a half-line, but usually a full line or more.

Graphic Indicator

& Readers need to be shown when new paragraphs
begin. The most common method of indicating new para-
graphs is a paragraph indent — usually about one em in
length, longer for wide paragraphs. # There are other
methods of indicating the start of new paragraphs. Para-
graphs can be separated with space — by at least a half-
line, but usually a full line or more. &

Negative First Line Indent

Readers need to be shown when new paragraphs begin. The
most common method of indicating new paragraphs is a
paragraph indent — usually about one em in length,
longer for wide paragraphs.

There are other methods of indicating the start of new para-
graphs. Paragraphs can be separated with space — by at
least a half-line, but usually a full line or more.
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Orphans & Widows

When the last line of a paragraph is less than one-third of a line or
so, the line is called a widow. If the widow flows to the top of the
next column it is called an orphan. Widows and orphans both
should be avoided. Similarly, never begin a paragraph when only
one line will fit at the bottom of a column before flowing to the tof
of the next column.

Tracking is often helpful in fixing orphan/widow/stray line prob-
lems by increasing or decreasing letter spacing. For example, if the
widow is the second half of a hyphenated word, you can pull text
closer together by employing negative tracking (i.e., a tracking
value of less than zero) to bring the widow up with the previous
line. Or, sometimes a positive tracking value may be used to insert
more space between characters to add more text to the widowed,
orphaned, or stray line.

Widow

When the last line of a paragraph is less than one-
third of a line or so, the line is called a widow. If the
widow flows to the top of the next column it is called
an orphan. Widows and orphans both should be
avoided.

Orphan

avoided.
If the widow flows to the top of the next column it is
called an orphan. Widows and orphans both should be

Stray First Line of Paragraph

Similarly, never begin a paragraph when only one line
will fit at the bottom of the column before flowing to the
top of the next column.

Tracking is often helpful in fixing orphans/widows/stray lines
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White Space

Leading

White space is one of the most important elements of page design.
Advertisers know that the more white space a page contains, the
more readers will pay attention to the ad.

This may not set well with copywriters, but research shows that distri-
bution of white space increases ease of reading more than improve-
ments in writing style. White space makes a page look more interest-
ing and less difficult to read. And, often, getting readers to look at an
advertisement or other publication is the first step to having them
read and understand the message.

Increased white space can be achieved through a number of de-
sign techniques. Increased leading increases the amount of white
space between lines. Tracking and kerning allow for adjustment of
white space between characters and words for maximum legibility
and readability.

Line length — the horizontal width of lines on a page — has a
noticeable affect on readability. If line length is too short, text
appears choppy — too long, and the reader’s eyes become weary
and confused.

Leading has a very noticeable effect on legibility. Increasing the space
between lines adds white space. Less space between lines gives a page
a more compressed, “black” look.

Leading, a term originally coined in the days of hot-lead typesetting,
referred to the thin strips of lead typesetters placed between lines of
hot type to add space. In electronic publishing, the term “leading” has
come to mean the space occupied by the type font size plus the
amount of space between lines. What traditional typesetters would
call linespace is called leading by electronic publishers.

_lLeading has a very noticeable affect on legibility. paseline

leading * _|ncreasing the space between lines adds white space. .
baseline

12-point Font
16-point Leading (Baseline-to-baseline)
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Generally, Auto Leading, the default setting for leading in

QuarkXPress, provides good results for text type. If Auto Leading
is selected, and the default leading value of 20 % is left unchanged,
the program will automatically set leading to 120% of the font size.
For example, lines of 10-point type would be separated by 2 points

of leading when automatic leading is employed:

(10-point type x .2 = 2 points)

Two-point space between lines added to the 10-point font size
yields a total leading value of 12 points.

While Auto Leading provides good results, Absolute Leading is
the best choice for precision typesetting, as it gives the most con-
trol over how lines are spaced throughout a document.

Type Set Solid

If type is “set solid” there is no space between lines. Ten-point type
with 10-point leading would be set solid. Type set solid usually
appears too black on the page and has a negative affect on legibility.
Only type with a small x-height (type with large ascenders and
descenders) and light weight should be set solid. Fonts with larger
x-heights and bolder weight should have some added space

between lines.

Two examples of type “set solid” are shown below. One example
shows a font with a large x-height, the other with a small x-height.
Notice how much darker the Helvetica (large x-height) type looks
in comparison to the Garamond (small x-height) when set solid.

If type is “set solid” there is no space
between lines. Ten-point type with 10-point
leading would be set solid. Type set solid
usually appears too black on the page and
has a negative affect on IegibilitP(. Only type
with a small x-height (type with large
ascenders and descenders) and light
weight should be set solid. Fonts with larg-
er x-heights and bolder weight should have
some added space between lines.

Helvetica 10-point
Large x-height
et Solid

4-24

If type is “set solid” there is no space
between lines. Ten-point type with 10-point
leading would be set solid. Type set solid
usually appears too black on the page and
has a negative affect on legibility. Only type
with a small x-height (type with large
ascenders and descenders) and light weight
should be set solid. Fonts with larger x-
heights and bolder weight should have
some added space between lines

Garamond 10-point
Small x-height
Set Solid
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Specifying Type

Typesetters and designers have developed a standard system for
specifying type. 10-point type set with 14 points of leading is writ-
ten 10/14. 10-point type set solid is specified as 10/10 — 10-point
type, 10-point leading.

The examples below show type set with varying amounts of lead-
ing. Notice how type set with less leading appears blacker than
type set with a greater leading value.

Leading Set Solid (10/10)

Leading, a term originally coined in the days of hot-lead
typesetting, refers to the thin strips of lead typesetters
placed between lines of hot type to add space. In electron-
Ic publishing the term “leading” has come to mean the
space occupied by the type (font size) plus the amount of
space between lines.

Auto Leading

Leading, a term originally coined in the days of hot-lead
typesetting, refers to the thin strips of lead typesetters
placed between lines of hot type to add space. In electron-
ic publishing the term “leading” has come to mean the
space occupied by the type (font size) plus the amount of
space between lines.

Leading Set to 20 Points (10/20)

Leading, a term originally coined in the days of hot-lead
typesetting, refers to the thin strips of lead typesetters
placed between lines of hot type to add space. In electron-
ic publishing the term “leading” has come to mean the

space occupied by the type (font size) plus the amount of

space between lines.
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Line Length

Line length can affect both readability and the overall aesthetic
design of a piece. In general, the larger the font size, the longer a
line of text can be. If a line is too long the reader may have to
search for the beginning of each line. Lines which are too short
cause words and phrases to become broken, choppy and difficult
to read. Multiple columns are preferable to long columns, as

long as the multiple columns are not too short for good readabilit

Readability research indicates that the most readable line length is
about one-and-a-half or two lowercase alphabets long.

Another measure for good line length is 8-12 words.

Like leading, ideal line length is a function of x-height and font
size. Fonts with large x-heights can be set in longer lines. Small
x-height fonts should be set in shorter lines.

Some other guidelines about choosing proper line length... long
lines are better for books and long articles; short lines are more ea:
ily incorporated into graphic designs commonly found in promo-
tional or other shorter pieces; it is better not to justify short lines
this may result in too much excess white space.
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Line Length Set Too Short

Line length can affect both
readability and the overall
aesthetic design of a
piece. In general, the larg-
er the point size, the
longer a line of text can
be. If a line is too long the
reader may have to
search for the beginning of
each line. Lines which are
too short cause words and
phrases to become bro-
ken, choppy and difficult to
read.

abcdefghijkimnopqrstuvwx

Line Length Set Correctly

Line length can affect both readability and the
overall aesthetic design of a piece. In general,
the larger the point size, the longer a line of text
can be. If a line is too long the reader may have
to search for the beginning of each line. Lines
which are too short cause words and phrases to
become broken, choppy and difficult to read. Mul-
tiple columns are preferable to long columns, as
long as the multiple columns do not wind up
being too short for good legibility.

abcdefghijklmnopqrstuvwxyzIabcdefghijklmnopqr

Line Length Set Too Long

ie length can affect both readability and the overall aesthetic design of a piece. In general, the
ger the point size, the longer a line of text can be. If a line is too long the reader may have to
arch for the beginning of each line. Lines which are too short cause words and phrases to
come broken, choppy and difficult to read. Multiple columns are preferable to long columns, as
g as the multiple columns do not wind up being too short for good legibility.

:defghijklmnopqrstuvwxyzlabcdefghijklmnopqrstuvwxyzlabcdefghijklmnopqrstuvwxyzlabodefghi
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Mixing Fonts & Sizes

18-point Type ——

10 -point Type

A particular design may call for more than one font size or font.
While multiple sizes or styles may be appropriate for emphasis ¢
other design objectives, it is important not to clutter a page with
too many of them.

Another concern when specifying multiple fonts in a document i
printer memory capacity. Too many fonts can increase print time
and may overwhelm the printer’s memory capacity. Often, diffi-
culties in printing a document are caused by too many fonts. The
Font Usage (Utilities menu) feature is helpful in allowing you to
check the number of fonts specified in a document.

When setting type with multiple fonts, sizes, or type styles,
remember to allow enough leading for the largest font. If Auto
Leading is selected, QuarkXPress will insert enough leading for
the largest font on the line. But, as the first example below demor
strates, if a line contains a font larger than the the text body, that
line will be over-leaded in comparison to the rest of the text. By
specifying an absolute leading value large enough to compensat
for the over-sized font, the paragraph has uniform, equal leading
as shown in the second example.

Auto Leading Set to 20%

A particular design may call for more than one font size

or font. While multlple SIZES or styles may be

appropriate for emphasis or other design objectives, it is
important not to clutter a page with too many.

18-point Absolute Leading

A particular design may call for more than one font size
or font. While multlple SIZES or styles may be
appropriate for emphasis or other design objectives, it is

important not to clutter a page with too many.
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Tracking

Adjusting tracking allows you to control the amount of space
which type occupies. Negative tracking values (less than zero)
squeeze characters closer than normal. Positive tracking values
spread characters apart. Tracking allows adjustment of both let-
terspacing and word spacing in a single operation.

Tracking makes it possible to fit copy into a space which normally
would be too large or too small for the amount of text. Too much
tracking, however, can have a negative affect on legibility, as text
becomes too condensed and the page takes on a darker look. Loos-
ening type will cause a page to look lighter than normal.

In general, display type can be set tighter than text type, as tight
letterspacing affects legibility in large blocks. Condensed fonts can
be set tighter than regular or extended faces. The examples at the
right show type set at different tracking values.
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Examples of Tracking

Below are examples of 12-point Helvetica type tracked at differ-
ent amounts. Notice how much darker the text of tight tracking
examples appear when contrasted with the looser type.

Touching Letterspacing, Tracking Set to -10

Adusting fracking alows you 1o conirol the amount of Space type cooUpes.
Negative tracking values (less than zero) squeeze characiers doser than
nomal. Posiive tracking values spread characiers apart. Tracking alows
adustment of both letierspading and word spacing in a single operation.

Tight Letterspacing, Tracking Set to -5

Adijusting tracking allows you to control the amount of space type
occupies. Negative tracking values (less than zero) squeeze
characters closer than normal. Positive tracking values spread
characters apart. Tracking allows adjustment of both letterspac-

ing and word spacing in a single operation.

Normal Letterspacing, Tracking Set to 0

Adjusting tracking allows you to control the amount of
space type occupies. Negative tracking values (less than
zero) squeeze characters closer than normal. Positive
tracking values spread characters apart. Tracking allows
adjustment of both letterspacing and word spacing in a
single operation.

Loose Letterspacing, Tracking Set to 5

Adjusting tracking allows you to control the amount
of space type occupies. Negative tracking values
(less than zero) squeeze characters closer than
normal. Positive tracking values spread characters
apart. Tracking allows adjustment of both letter-
spacing and word spacing in a single operation.
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Kerning

Kerning is the adjustment of white space between individual char-
acter pairs. While QuarkXPress features automatic kerning, based
on kerning tables which are created by the font manufacturer, it is
sometimes necessary to further kern certain character pairs to
obtain the desired look. How much space to take away during
kerning is determined visually — i.e., how does it look?

It is often difficult to tell whether a character pair requires kern -
ing until a hard-copy proof is printed. When proofreading laser
printed or phototypeset output, check for character pairs which
require kerning.

Kerning is easily accomplished via the keyboard $z-shift-[ (to
decrease space between character pairs). Use the dialog box to
enter specific kerning values.

Because of the time it takes to manually kern letter pairs, kerning is
usually reserved for display type or short blocks of text.

The following list contains the character pairs which require kern-
ing most often.

Top 20 Kerning Pairs

The table below lists character pairs which require kerning most fre-
quently. The pairs shown here have been kerned using QuarkXPress’
automatic kerning. The pairs listed here are the most likely to require

kerning — especially in display type.

1. Yo 11. B

2. We 12. Ty
3. To 13. Wa
4. Tr 14. yo
5. Ta 15. we
6. Wo 16, T.

7. 14 17 Y.

8. Tw 18. TA
9. Ya 19. PA
10. Te 20. WA
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Examples of Kerning

The pairs shown below have been kerned with the Auto Kerning
feature, based on the font designer’s specifications. Some pair
sets show the effects of additional manual kerning, as marked.
The last set of pairs are completely unkerned.

We To Ya T

Manual Kerning Set to -10

We To Ya T /o

Manual Kerning Set to -5

We To Ya T. /o

No Manual Kerning

We To Ya T. /o

Unkerned
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Laser Printing

PostScript is a page description language — it is the language
that your Macintosh uses to communicate with a laser printer or
phototypesetting print device. PostScript has the ability to
describe text, images, and graphics so that laser printers can
reproduce with great accuracy what you create on your screen.
PostScript description of images allows high-resolution printed
output because curves and lines are defined mathematically —
rather than pixel-by-pixel, as bitmaps are defined.

Printer resolution is measured in dots per inch (dpi). The fewer dots
per inch, the poorer the resolution of printed output. Most dot
matrix printers have a resolution range of about 60-120 dpi, and are
not really very useful to electronic publishers except for making
draft print-outs. The ImageWriter® prints at 72 dpi.

¥ i dpi

Ranging in resolution from 300-600 dpi and greater, laser printers
are adequate for most applications. Newsletters, in-house docu-
ments, price sheets, letters, and most documents produced on a day-
to-day basis can be output to a laser printer with good results. In
fact, many documents output on high-resolution phototypesetting
devices probably could have been printed to a laser printer instead.
The LaserWriter® prints at 300 dpi.

300 dpi

Phototypesetting print devices use a photographic process to
print onto photographic paper or film. With output resolution
capabilities of up to 2540 dpi, phototypesetting devices, such as
the Linotronic™ should be used to output text and artwork for
high-impact documents such as brochures and other materials
which require the crisp look afforded by high resolution print
devices. High-resolution artwork is best reproduced using glossy
paper stock.

1270 dpi
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Advanced Text Run-around

Text run-around wraps text around irregularly shaped graphics and
artwork.

To use run-around, just place the graphic, click Transparent and
Run-around, and watch the program do the rest. See the Run-
around section in the Reference Manual under Modify (Item menu)
for specific instructions about running text around objects.

The program uses math, not aesthetics to run text around an object.
For most objects, the inset margin can be adjusted so that text will
not run into areas which the designer prefers text-free. However, if
text flows into an area where no text is desired, place an invisible
object such as an empty text box or invisible line to keep text from
entering the area.

In the example below, the circle on the right highlights an area where
an invisible object, in this case a line shaded to 0% black, has been
placed to keep text from running into the open area. The square on
the left shows a similar area unmodified, with text running between
the squash blossoms.
The program uses math, not aesthetics to run text around an object. to run text around an object. For most objects, the inset margin can bx
For most objects, the inset margin can be adjusted so that text will adjusted so that text will not run into areas which should be text
not run into areas which should be text-free. However, if text free. However, if text flows into an area where no text is desired
flows into an area where no text is desired, place an invisible place an invisible object such as an empty text box or invisible
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The remainder of this section contains examples describing: modi-
fication of text run-around, contouring text, and running text
inside a hollow object. These examples are presented in a step-by-
step format for easy replication. The first step-by-step example
below illustrates how the modification to the run-around on the
facing page was achieved.

Modification of Text Run-Around

Lines or other objects can be used to modify text run-around.
Obijects used for forcing text in this way must be made invisible so
they do not print. To make an object invisible, shade it to 0% of any
color, or make the object the same color and shade as the back-
ground against which it is placed.

1. Notice how the text runs between the silver squash blossoms in
the picture below. Text can be moved out further by increasing the
Text Outset value in the Picture Box Specifications dialog box.
But, say, for example, the design called for the current Text Outset
value — and the run-around as it is shown here is unacceptable.

Y text.oox.of .
the.entrance 4
The.program .
aesthetics.to.ry

i places youdontwant.i, |

object. like .an. empty. tex}
Lover.the .entrance o force.around
es Jmath, .not.aestNedics. to.run.text 4

br.most.objects, the .inset margin.c3
Lext.willnotr uninto.areas which yol
8 ontinues lofpw into o Rced

2. Force the text out by drawing an invisible, non-transparent object. In
this example we use a line as shown below.

€Xt.DoX . of
the.entrance|
The .program
aesthetics.to.r]

object.lke .an.empty. tef
jne .over.the .enrance to force.arou
hses math, .not.aestnetcs, to.r un.texy
or.most.objects, .the .inset margin.d
Jat text.will.notr uninto.areas swhich i

R A iextconioues lofowinio RRCS
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3. After drawing the line, make it non-transparent by clicking off
Transparent in the Line Specifications dialog box (Style menu).

invisble.object.lke.an
Invisble.line .oyer the.enrance.to.f
.uses.matn, .not.
an.object. .For.most.objects, the. if
Jdjusted.so. that text..will.not. run. inf
Aol textfree Butliextconting

4. Next, make the line invisible by making it a 0% shade of any
color — in this case, 0% black. With the line selected, choose
the color black from the line Style menu.

Y text.pox.or
the.entrance
The.program
aesthetics.to.ny

be.text-ree . But. F .tex]
K into .places.you.don
invisble.object .lke.an.
hvisble.line .over the.enrance.to.fof
frogram ., uses . mam, .not. aesthetics .4
n.object. .For.most .objects, .the. ing
Histed.so. that text.will.not. run. intg
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Contoured Text

Like jello, contoured text retains its form even though the mold is
gone. The effect is created by having the text run around a graphic
which is not printed (because it has been selected for Suppressed
Printout) — giving the impression that the text is contained in an

oddly shaped text box.

Another method of contouring text is to draw a line with Quark
XPress, and make it invisible (shaded to 0% or colored like the
background). Against a white background a white graphic appears
invisible. The contour shown below was created with a Quark

XPress line shaded to 0% black.

Like jello, contoured text
retains its form even though
the mold is gone. The effect
is created by having the text
run around graphics which
have been colored white
(hence, invisible on a white
background). Text can be

contoured along graphics cre-
ated with the line tools avail-
able in QuarkXPress, or along
an EPSF or PICT graphic cre-
ated with another program. If
you wish to have an imported
graphic appear as white in
Quark XPress, it must be col-
orized in the other program,
then imported.

Contoured Text
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Contoured Text Step-by-Step

1. Place the object which you wish to use as the contour in the propet
position in relation to the text. In this case the contour object is a
QuarkXPress line, as shown.

ST S ———————

2. With the line selected, click off Transparent in the Line Specifica-
tions dialog box (Item -~ Modify). The line will force the text along
side it if it is placed correctly.

LEF
%i:g

3. Draw in the second contour object. This example uses a second
QuarkXPress line. Make it opaque by clicking off Transparent in
the Line Specifications dialog box (Item > Modify).

4. Make each line invisible. Begin by activating a line. Shade it to 0%
black by selecting Shade from the Style menu, then highlighting
0% in the Shade sub-menu. Repeat the procedure with the other line.

CHAPTER 4: TYPOGRAPHY AND DESIGN



Running Text Inside a Hollow Object

The previous step-by-step example demonstrates how to run con-
toured text using an invisible object to mold text. The following exer-
cise demonstrates how to run text inside an invisible object — or, actu-
ally, two identical objects placed precisely on top of each other.

The faster we go the
rounder we get — in the fourth
dimension. The faster we go the
rounder we get — in the fourth dimension.

The faster we go the rounder we get — in the
fourth dimension. The faster we go the rounder we
get — in the fourth dimension. The faster we go the
rounder we get — in the fourth dimension. The faster we
go the rounder we get — in the fourth dimension. The
faster we go the rounder we get — in the fourth dimension.
The faster we go the rounder we get — in the fourth dimen-
sion. The faster we go the rounder we get — in the fourth
dimension. The faster we go the rounder we get — in the
fourth dimension. The faster we go the rounder we get —in
the fourth dimension. The faster we go the rounder we
get — in the fourth dimension. The faster we go the
rounder we get — in the fourth dimension. The
faster we go the rounder we get — in the
fourth dimension. The faster we go the
rounder we get — in the fourth
dimension.

To fill a hollow object with text:

1.

Place the object inside the text box containing the text which
will fill the object.

Duplicate the object and place it directly over the original.
Divide each object in half. Reduce one object to only a left half
and the other object to only a right half.

If the object itself will be printed, make the halves overlap. If
the object is being used simply to shape the text, each half
needs only butt up against the other.

For each of the halves, click Transparent and Run-around
(Item > Modify) to force the automatic text run-around;
click Suppress Printout if you don’t want the object itself to
be printed.
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Running Text Inside a Hollow Object Step-by-Step

1. Tofill a hollow object with text, begin by drawing a picture box
inside the text box containing the text you want as the fill text.

It is important that the graphic object you fill is roughly the same
size as the text box. Text must be forced to flow into the graphic
object; if the text box is too large, there will be nothing to constrain
the text and cause it to flow into the object.

2. Import the hollow graphic. (The example below uses a circle,
drawn in a paint program, as the hollow graphic.)

3. Duplicate the picture box containing the graphic using the Step
and Repeat command (ltem >~ Modify). By setting the Horizontal
and Vertical offsets to zero, you can place the duplicated copy
directly on top of the original.

Step and Repeat

Repeat Count: \

Horizentel 0ffset: (0

Uerticel 0ffset: |0
)

4. Next it is necessary to split each picture in half — in effect creating
two arcs against which the text will run. Click on the stack of boxes
the top picture box will become selected.
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5. Grab the left handle of the selected picture box and move it toward
the middle. The arrow shown in the example below, illustrates in
which direction the picture box handle is moved — from the outer
edge to the middle.

6. Notice that the left portion of the circle in the bottom picture box is
now visible. An ‘X" marks the visible area of the bottom picture box.
Select this picture box and bring it to the front by clicking in the area.

7. Grab the right handle of the newly exposed bottom picture box.
Move it toward the middle as you did the top picture box.

P
L)
N

Notice, you can now see two arcs: the right side of one picture
box and the left side of the other.

N
\
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8. Select one of the arcs. Make text run around it by clicking on

Transparent and Run-around (Iltem ~ Modify). In order to keep
the circle itself from printing, and to create the effect of text set in
circular block, click on Suppress Printout.

9. With the other arc selected, repeat the instructions in #8 above.

10.Click elsewhere on the page to view the effects of the run-around.

Notice how the text begins outside the circle. Use a carriage retur
to push the line down and bring the text inside the circle.

Text will try to flow through the largest open horizontal area of a
column first. In this circle example, the right side of the column (to
the right of the graphic) has the largest horizontal area, so the tex
tries to flow first to the right. As the top picture shows, only one
line flows outside the graphic. Once the area inside the circle is
larger than the area on either side of it, text begins to flow within

the circle.

Text can be forced inside the graphic by drawing a non-trans-
parent graphic element such as a line or an empty text box (as
demonstrated in the section “Advanced Text Run-around”). How
ever, in this case, a simple carriage return is sufficient to achiev

the desired result.
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Initial Caps

Large, uppercase characters set into a body of text are called initial
caps. Initial caps help to break up large blocks of text. They can be
used to start a story, to start a paragraph, or to help guide the read-
er’s eye to a particular point. Initial caps can be versions of the dis-
play or body text modified using the Style menu in QuarkXPress,
or they can be designed with a graphics program, and imported
into a document as a picture.

There are three basic types of initial caps: drop caps, raised initials,
and hanging caps.

Drop caps are set within the text body. The top of the drop cap
should align with the cap height of the first line of body text and
with the baseline of the bottom line adjacent to the inset. Text can
be run around the contour of the drop cap character, or text can be
blocked out around the drop cap. Raised initials align with the
baseline of the first line of text, and are the easiest to create.

If the initial cap is a word (like “A” or “I”), be sure to set enough
space to the right of it so the reader is not confused by the effect

Raised initials are a useful and easy-
o-implement design element. Para-
[raphs containing a raised initial must
1ave leading set to an absolute value,
1s the larger type style will throw off the
2ading of the first two lines.

Raised Intitial

rop caps are set within the text

body . Drop caps should align at

top with the cap height of the
irst line of the body text and with the
»aseline of the bottom line adjacent to
he inset. Text can be run-around the
sontour or of the drop cap character, or
he text might only be blocked out
around the drop cap.Drop caps are set
wvithin the text body.

Blocked-in Drop Cap

drop cap is set within the body

text. Drop caps should align at

top with the cap height of the

first line of the text body and

with the baseline of the bottom line adja-

cent to the inset. Drop caps should align

at top with the cap height of the first line

of the text body and with the baseline of
the bottom line adjacent to the inset.

Contoured Drop Cap

anging caps are not as
common as the other initial
cap designs. Place a
hanging cap in the margin
against type which is set
flush left (left justified).

Hanging Cap
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Raised Initials

Raised initials are a useful and easy-to-implement design ele-
ment. Paragraphs containing raised initials must have leading s
to an absolute value, as the larger type style will throw off the

leading of the first two lines.

1. Select the character you wish to use for the raised initial.

2. Increase the size of the raised initial to the desired font size.

ked'initials
and.easy-to-mpl
element..Para
containing-a-rais
must-have-leadi

3. Notice that the leading (if auto leading is being used) increases
to accommodate the largest character on the line. To compen-
sate for this effect, specify an absolute leading value. In this
example, the leading was set solid — or set to 12 points, the

same value as the font size.

Raised'initia
vu.}] uwv ni I}JIVI
element.-Paraq
raised-initials-n
set-to-an-absol

30-point Helvetica

The example to the left has the
top line overlapping onto the
second line. This screen result
is due to the leading associatec
with the R's font size. This is ¢
screen effect and is not printed
as you can see from the exam-
ple below.

Raised initials are a useful and easy-to-

12-point Helvetica implement design element. Paragraphs
containing a raised initial must have leadin
set to an absolute value, as the larger type
Raised initial face will throw off the leading of the first tw

Absolute leading set to 12 points  lines.
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Hanging Caps

Another unusual initial cap design is the hanging cap. This graphic
element is simple to create and can add spark to a design.

1. Begin by drawing a text box to the left of the text against which
you want the hanging cap. Type the hanging character in the
newly drawn box.

T

2. Increase the font size so that the hanging cap is the proper
height to meet the design objectives.

3. Aesthetically, the hanging cap looks better if it is narrower than
normal for the font size. The example shown below has been
horizontally scaled to 60%.
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4. Because the hanging character should be flush against the text, it
is necessary to make the cap's text box transparent. With the
hanging character's box selected, click on Transparent in the Tex
Box Specifications dialog box (item > Modify).

Anging<aps are
ias-the other-initk

iPlace.a-hanging
imargin-against.
flush ket (left jus

5. Position the cap as required.

anging caps are not as common
as the other initial cap designs.
Place a hanging cap in the margin
against type which is set flush left
(left justified).

Hanging Cap
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Blocked Drop Caps

1. Draw a small text box in which you will type the drop character.
The drop cap text box should be drawn inside the text box contain-
ing the text which will wrap around the drop cap.

[® =

op ¢
thir
ext.
hou
tht
iheight of the first
oot b 3

2. Type the drop character in the newly created text box and make it
the appropriate font, size, style, etc.

D op cap

' thin th
Drop ¢

. lign at

cap height of the
the body text and
|baseline of the by

3. Move up the bottom edge of the box until the text line beneath the
drop cap is free to run all the way to the left margin.

rop cap:
within th
Drop caf

lign at
cap height of the
the body text and
baseline of the b{

4. Move the right edge of the box to the left until the desired effect is
achieved, or until the box becomes too small and the character
causes a text overflow.

T Top Caps
the body |
B’ caps shol
top with the cap
first line of the bg
with the baselin

boltom li

CHAPTER 4: TYPOGRAPHY AND DESIGN 4-47



Contoured Drop Cap

Text runs around contoured drop characters. The effect is created
by using a letter produced in an art program and saved as an
EPSF picture.

1. Draw a small picture box inside the text box in which you will
import the drop character. Import the drop character.

drop cap I- drop cap

wikhin the ] Zs wihin the

text. Drop fext. Drop)
$HoUTd align at tg Sh&uld align at to
the cap height of the cap height of
line of the body t line of the body
wih the baseline wih the baseline

2. If necessary, resize the drop character via the Width and Height
fields in the Text Box Specifications dialog box.

3. Use the Hand Tool to move the drop character into the correct
position.

4. Cause the text to run around the drop character graphic by clicking
on Transparent and Run-around in the Text Box Specifications
(Item > Modify) dialog box.

drop cap is
At he body t
¢aps shog
ialtop with the ¢
of the first line of
text and wkh the

of the boltom lind
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5. Notice how the text runs flush against the drop character graphic.
Use Text Outset in the Text Box Specifications dialog box to force
the text uniformly out from the edge of the graphic. The example
shown here was created with an Outset value of four points.

drop cap is {
At he bodly t
¢aps shou

at top With the ca
of the first line of
text and with the
of L i

6. Deselect both the text and picture box by clicking elsewhere on the
page. This will cause text to run around the graphic. If necessary,
reposition the drop character graphic again, using the Hand Tool until
it looks right.
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Glossary

ctive

An active object is selected and available for use or modification. A box or line is
made active by clicking on it. An active box has a dark outline and handles, and an
active line has handles at either end. An active paragraph is one that contains the
insertion point | or one in which some or all of the text is selected.

lignment

Paragraph alignment determines placement of text within a box or column. In
QuarkXPress, paragraph alignment can be left, right, centered, or justified. Tab
alignment determines alignment of text on tab stops. In QuarkXPress, tab alignment
can be left, right, centered, or decimal.

scender

An ascender is the part of the lowercase letter which rises above the x-height, as in the
letters b, d, f, h, k, 1, and t.

spect ratio

Aspect ratio is used in reference to resizing text and picture boxes. It refers to the ratio
of width to height.

wtomatic hyphenation

Automatic hyphenation is a QuarkXPress feature that divides words into two
parts at a syllable juncture to achieve elegant justification or better spacing in lines
with ragged margins. This automatic feature can be tailored manually with
Hyphenation Exceptions.

wtomatic kerning

Automatic kerning uses specific kerning tables designed for each font to adjust space
between pairs of letters to improve appearance.

wutomatic linking

Automatic linking connects overflow text from one text box to a specified text box on
a newly inserted page.
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Baseline
The baseline is the line upon which uppercase and most lowercase characters sit.
Box

The box is the basic formatting element for QuarkXPress. Text boxes contain text, and
picture boxes contain pictures. Both types of boxes can contain other boxes or lines.
Box outlines show on the screen when a box is active or Show Guides is selected, but
do not print.

Centered

Centered is a paragraph setting in which every line of text is centered within the
margins; it also refers to a type of tab stop on which text is centered.

Chain
A chain is a set of linked boxes through which text flows.
Child box or child line

A child box or child line is created inside a parent box. Placing the pointer inside a
box when starting to draw a box or line makes it a child box or line (to that parent
box). A child box or line cannot exceed or be moved outside its parent, and actions
such as deleting or moving a parent box will delete or move the child box or line as
well (see Parent box).

Color separations

Color separations are used in the color printing process. There are two types of
separations: spot color and process color. When printing spot color separations,
QuarkXPress will print one page (or plate) for each of the spot colors found on a
given page. Process separations consist of four separation plates for each page: cyan,
magenta, yellow, and black. When spot color is defined on a page containing items
that require process separation, both the spot color plate(s) and the process color
separation plates are printed (see Spot Color Separations).

Corner radius

The corner radius is the circular radius which defines a rounded corner to be
placed on a picture box. In QuarkXPress, use the rounded-corner rectangle
picture box creation tool ® to draw boxes for which you can specify the radius
for the four corners.
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rop

Cropping is the technique of trimming the edges of an illustration in order to fit the
illustration correctly and artistically within a given space or frame.

utmarks

Cutmarks are short vertical and horizontal lines which, when printed on a document
with a smaller page size than the paper printed on, outline the document area.

ecimal alignment

Decimal alignment is a tab setting which aligns decimal numbers in columns along
a decimal tab.

efault
Default refers to the setting(s) for functions or features that are employed unless
the user specifies something different. For some QuarkXPress functions, the user

can define new default settings that apply either to all documents or to
specific documents.

efault page
Unless Show Default (Page menu) is selected, the default page is invisible. The
default page allows you to define a page format for pages which are inserted into
a document — either automatically or manually. A revised default page does not
change pages already in a document. Only newly inserted pages contain revised
default page information.

escender

A descender is the part of a lowercase character which drops below the baseline, as in
the letters p, g4, y,j, and g.

ialog box

A dialog box is a box which requests information from the user. Some dialog boxes
warn the user of an error or of the possibility of losing work.

iscretionary hyphen

A discretionary hyphen is a hyphen character within text which is displayed and
printed only if it is needed at the end of a line to break a word.
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Display type

Display type is larger than 14 points and is generally used for headlines and
advertising copy.

Drop capital

A drop capital hangs below the top line and takes the vertical space of more than one
line at the beginning of a paragraph. In QuarkXPress, drop capitals can be created by
using a separate text box for the dropped capital.

Em space
Em space in traditional typesetting meant a square of a given point size. A 12-point
em would be a square of 12 x 12 points. An em space in QuarkXPress is the horizonta
space taken up by two zeros “00” in a given font. Kerning and Tracking use the em
space as the basic measurement unit. QuarkXPress kerns and tracks in increments of

.005 (1/200) of an em space. Entering “5” in the Kern/Tracking dialog box would set
the value to 5/200 (1/40) of an em space.

En space

An en space is one-half the width of an em space. In QuarkXPress, an en space is the
width of the character “0” (zero) in a given font — or one-half of an em space.

End caps

End caps are figures, such as arrowheads, which end, or cap lines.

Fill character

A fill character is automatically inserted from where the tab key is pressed to the
beginning of material that is located by the next tab stop. Any printable character
may be used.

First-line indent

The indent of the first line of a paragraph is referred to as first-line indent. The zero-
point is the same as the left-margin point. In QuarkXPress, the default setting is 0.
Negative values produce a hanging indent, and positive values produce an indent to
the right of the left margin.

Flush left (ragged-right)

Flush left is a paragraph setting in which the text abuts the left margin and has a
ragged right margin — sometimes referred to simply as “left,” or “left justified. ”
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ush right (ragged-left)

Flush right is a paragraph setting in which the text abuts the right margin and has a
ragged left margin — sometimes referred to simply as“right, ” or “right justified.”

nt
Font in desktop publishing has the same meaning as typeface to traditional

typesetters. A font is a set of characters with the same basic design, such as
Helvetica, Times, etc.

ont size

Ideally, font size reflects the space between the tallest ascender and lowest descender
in a given font. Exact font description criteria varies according to the font designer.

ormat

Format refers to the overall ordering and layout of material. Paragraph formats
usually include margins and tab settings. Character formats include font, type style,
font size, and other style attributes.

rame
A frame is a border which is used to separate and make a picture or block of text
stand out from the rest of the items on the page. Assign frames to a box through use
of the Frame command (Item menu).

ray screen

The Gray Screen field is used to define the number of lines per inch (Ipi) at which all
halftone pictures within a document will be printed. Selection of a Gray Screen Ipi
value should be determined by the type of paper a document will be reproduced on.

reeking
Traditionally, greeking was used to describe the mock text designers pasted into a
design to represent the finished copy. In QuarkXPress, however, greeking is a graphic

representation of text used to speed up screen displays. The gray greeking bars are
approximately the same height as the text they represent.

utter

In QuarkXPress, a gutter is the white space between columns. A standard gutter
width is one pica, or 12 points (0.167").
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Hairline
A .25-point vertical or horizontal rule is called a hairline.
Hanging indent

A hanging indent occurs when the first line of a paragraph starts to the left of all othe
lines in the paragraph. See First-line Indent.

Horizontal scale

The term horizontal scale refers to an adjustment of the horizontal dimension of one
or more characters without changing height. Characters are uniformly distorted
horizontally to a percent of the original. In QuarkXPress, characters may be
horizontally scaled from 25% (one-fourth of normal) to 400% (four times normal).
100% is normal. Compare with Tracking, in which the distance between characters is
adjusted without distorting the characters.

Hyphenation

Hyphenation is the dividing of a word into two parts at a syllable juncture. In
Suggested Hyphenation, QuarkXPress shows choices of hyphenation points in multi-
syllable words. Hyphenation is used to achieve elegant justification or to attain better
spacing at the ends of lines with ragged margins.

Hyphenation exceptions
Exceptions to the QuarkXPress built-in hyphenation rules may be made by entering
your own preferred hyphenation choices. For specified word(s), you may override th
rules and remove all hyphenation options, expand the number of hyphenation
choices, or limit the table by indicating a single hyphenation option.

Indents
Indents determine where, in relation to the margins, lines of text begin and end.
In QuarkXPress, indents are specified in relation to the edges of text boxes

and columns — not the edge of a page. Text inset must be considered in
designing indents.

Justify

To justify a line of text is to fit the line to a box or column width, so the text will have
uniform left and right margins.
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ern

Kerning adjusts the amount of white space between letter pairs. The term can be used
both as a verb and as an adjective: to kern the pair; it is a kerned pair.

QuarkXPress uses tables built into the font to perform kerning automatically. Manual
kerning can be accomplished in increments of .005 (1/200) of an em space.

eading
Leading, in traditional typesetting, meant the space between lines. Originally, strips
of lead alloy were used to increase the space between lines. In desktop publishing the
term has come to mean the measurement of space occupied by a line of text measured
from baseline-to-baseline. A leading value includes the font size plus the space
between lines. Leading has taken on the same meaning as the traditional typesetting
term linespace.

etterspacing

In QuarkXPress, the horizontal space between letters is adjusted by tracking. Positive
tracking values increase letterspacing, negative tracking shrinks the space between
selected characters.

igatures
A ligature is a single character used to represent two or more characters. While their
use is not as common as it once was, ligatures can still be found in some fine
typesetting. Examples of common ligatures include fi, ff, and fl.

inespacing

Linespacing is a traditional typesetting term which has been replaced by the term
leading in desktop publishing.

ink

In QuarkXPress, to link is to join text boxes together to make the text of a story flow
from one box to another.

paque

Opaque means non-transparent. In QuarkXPress, opacity of boxes and lines is
controlled by the Transparent and Run-around choices in the Modify command.
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Optional hyphen
See Discretionary hyphen.
Origin

The origin is the point at which the zero-points of the rulers at the top and left of
the document window intersect. The default setting is the upper-left corner of the
page. The origin can be moved to facilitate measurement on the page and to
control manual tiling.

Orphan

A single word or hyphenated portion of a word which makes up the last line of a
paragraph is called a widow. A widow which is carried to the top of a new column o
new page is called an orphan.

Page number characters
Page number characters — Current Page Number, Next Box Page Number and
Previous Box Page Number — are special characters used to represent the page
numbers of the previous box, current box and next box. These are used for page

numbering and to direct the reader’s attention to the page from which or on which
a story is continued.

Parent box
In QuarkXPress, a parent box is any text or picture box that holds another box or line

Pica

Pica is the base measurement in American typography. There are six picas to the inct
Picas generally are used to measure horizontal line space.

Point
A unit of measure in typography is the point. One point traditionally equaled 1/12
pica or just under 1/72 inch. But, in QuarkXPress and most other electronic
publishing applications, one point is exactly 1/72 inch.

Registration mark
A registration mark is a mark printed in the page margins and used for lining up

color separations, specifying tiling sections, or to delineate the edges of a page smalle
than the paper used for printing.
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esolution
Resolution is the precision of representation, which determines accuracy of
reproduction and distinctness of visual elements. For printer output and computer
screens, resolution is defined in dots per inch (dpi). The more dots per inch, the finer
the resolution. The resolution of the Macintosh screen and ImageWriter is 72 dpi, the

LaserWriter prints at 300 dpi, and high-resolution phototypesetting devices print at
1270-2540 dpi.

everse
Reverse is a descriptive term used to describe light letters on a dark background.

ules
Vertical and horizontal rules are lines which are used as graphic elements on a
typeset page. Generally, rules should not be thinner than one-half point. Rules smaller
than one-half point should not be set unless the document will be printed on a high-
resolution print device.

un-around

Run-around is a QuarkXPress feature which automatically flows text around a box,
picture, or line.

cale

To scale is to reduce or enlarge according to a fixed ratio. It is used in QuarkXPress
for resizing pictures and text.

ection

A section is a group of sequentially numbered pages. A document may contain
several sections.

eparations
See Color separations.
erifs

Serifs are the short strokes which project from the main strokes of a character. Sans
serif (without serifs) fonts have the same weight and thickness throughout.

GLOSSARY GL-11



Set solid

When leading equals point size, lines are said to be set solid, and are almost flush
against the line above and below.

Soft hyphen
See Discretionary hyphen.

Spot color
Spot color is used as a design element to highlight certain features within a documen
A document may have one or more spot colors. QuarkXPress prints text and graphic:

assigned a given spot color onto a separate “plate” so that each page in a document
may be reproduced in more than one color.

Story

A story, in QuarkXPress, is text that occupies a single, unlinked text box or a linked
chain of text boxes.

Style sheet

Style sheets in QuarkXPress allow users to save character styles, tabs, and margins.
Once created, style sheet format information can be applied to any paragraph.

Tab
A tab is set to align text or establish line indents at a predetermined location.

Text type

Text type is 14 points or smaller. It is used to set large blocks of text. You are currentl
reading text type.

Text inset

Text inset, in QuarkXPress, is the distance which separates text from the edges of its
text box. The default text inset for QuarkXPress is one point.

Thumbnails

Thumbnails are miniature representations of entire pages used to evaluate design an
to see the placement of text and graphics on more than one page at a time.
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Tiling is the process by which a document larger than the paper to be printed on can
be broken into sections the size of the paper, and then assembled.

‘racking

Tracking allows adjustment of white space between selected characters and words. By
specifying positive or negative tracking values, overall letterspacing can be adjusted.

ransparent

In QuarkXPress, items that are behind a transparent box can be seen.

'ype style

In QuarkXPress, type style refers to variations of a given type design (font) such
as bold, italic, outline, etc. The various type styles are available for each font and
each font size.

Inlink

To unlink, in QuarkXPress, is to break links between text boxes so that text will not
flow automatically from box to box.

Vidow

A single word or hyphenated portion of a word which makes up the last line of a
paragraph is called a widow. A widow which is carried to the top of a new column or
new page is called an orphan.

~height

X-height is the size of the lowercase “x” in a typeface. The term x-height refers to the
size of the main element of the character. X-height is not the same as the font size.
Font size is a combination of x-height plus the length of the ascender and descender.
The larger the x-height, the shorter the ascenders and descenders. A block of text with
a large x-height appears darker on a page than the same text set in a font with a
smaller x-height.
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QuarkXPress Symbols

=
The Command Key
&
The Mover Tool
X7
The Editing Tool. Use this tool for word processing functions in text boxes with the
pointer Y and the insertion bar [, and for moving illustrations around in picture boxes
with the hand pointer {7 .
7y
The Text Box Creation Tool
X
The Rectangle Picture Box Creation Tool
[02¢)
The Rounded-Corner Rectangle Picture Box Creation Tool
®
The Oval Picture Box Creation Tool
T3
The Orthogonal Line Creation Tool
N
The Line Creation Tool
N
The Arrow Creation Tool
"

The Double-headed Arrow Creation Tool
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luarkXPress Symbols, cont.

The Text Box Linking Tool or Intact Chain Icon

The Text Box Unlinking Tool or Broken Chain Icon

The Arrow Pointer

The Text Editing or I-beam Pointer

The Text Insertion Bar

The Picture Moving Pointer

The Crosshair Cursor is used for drawing boxes and lines, and the Crosshair Pointer for
editing frames. The Crosshair Cursor is also used to select colors from the color wheel.

The Box Resizing Pointer
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